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PREFACE

Welcome to the Oracle Insurance Insbridge Enterprise Rating Insbridge Upgrade Guide. The Insbridge
Enterprise Rating (Insbridge) System is a browser-based, multiplatform insurance rating and underwriting
technology solution that provides integrated management for every aspect of the rate definition and
modification process. The purpose of this guide is to assist with the upgrading of the Insbridge Enterprise
Rating System.

There are different types of upgrades available to the 04.09.00 release of the Insbridge system:

o RateManager/IBFA

SoftRater for Windows

SoftRater for WebLogic

SoftRater for WebSphere
o SoftRater for JBoss

This document focuses on upgrading RateManager/IBFA and SoftRater for Windows. Also included are
the steps for upgrading SoftRater for WebLogic, WebSphere, and JBoss.

AUDIENCE

This guide is intended for system administrators, installers, database administrators and others tasked
with installing and configuring the Insbridge system and associated databases.

TYPES OF INSTALLATION

There are various types of installations:

RateManager Installation

e RateManager for Windows — Installs RateManager and the Insbridge Framework Administrator
(IBFA) in a Windows environment and utilizes IBFA for local rating. This Windows only
environment uses a SQL Server database.

SoftRater Installation

o SoftRater for Java Installation — Deploys Insbridge SoftRater Server (IBSS) to an application
server; WebLogic, WebSphere, or JBoss, using a SQL Server database, or an Oracle database,
or a DB2 database.
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o SoftRater for Windows Node — This installation is for existing environments that want to add a
SoftRater for Windows node to an environment. This is for a Windows only environment using a
SQL Server database.

Upgrading a Current Installation

o Upgrade — Upgrades existing customers from their current version of Insbridge up to version
04.09.00.

This guide describes Upgrading an existing environment.

Definitions

Some commonly used terms when installing or using the Oracle Insurance Insbridge Enterprise Rating
system:

o IBER: Insbridge Enterprise Rating System. Most often referred to as Insbridge. This is the entire
system.

e IBFA: Insbridge Framework Administrator. IBFA is an administrative tool used to configure
Insbridge applications and setup RateManager database connections. IBFA will be located on a
Windows Server machine. IBFA/SR-WIN is an Insbridge Framework Administrator/SoftRater for
Windows.

o IBSS: Insbridge SoftRater Server. IBSS is the administrative tool for the SoftRater engine. The
SoftRater engine is a multi-platform component within Insbridge that executes the rules, rating
and underwriting instructions as defined by the user in RateManager. IBSS is usually located on a
Java machine. IBSS/SR-JAVA is an Insbridge SoftRater Server/SoftRater for Java.

o SoftRater Node: A SoftRater node is either an IBFA (without RateManager) or IBSS instance on
a physical environment.

o SoftRater Native: SoftRater Native is a remote instance of SoftRater that can execute rules and
rating logic in environments where access via the SoftRater web-services is not desired or
possible.

e RM: RateManager. RateManager is a component within Insbridge that enables users to manage
the product definition and modification process, including rating and underwriting logic.

e SR: SoftRater. The engine that executes the rating, rules and underwriting instructions defined
within RateManager. The rating environment for runtime execution and processing of business
content. SoftRater can be further defined by the operating system where it has been loaded.

e SR-WIN: SoftRater for Windows. This is also another name for IBFA.

o SR-JAVA: SoftRater for Java. This is also another name for IBSS.

e SRP: SoftRater Packages. A package that holds all the RateManager logic for a specific program
and version.
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VFS: Virtual File Servers. Virtual file server management allows you to access environments that
are located on other machines in different locations where packages can be downloaded.

Package Location: A pointer to a location where SoftRater Packages (SRP’s) are stored.
Physical Environment: A physical environment is generally referred to as a physical machine.
Authoring Environment: The physical machine where RateManager is installed.

Rating Environment: The physical machine(s) where SoftRater is installed. This is typically the
same as a SoftRater node.

Logical Environment: An environment created for a subscriber in IBFA. It defines package
location, engine location and database location in addition to several other supporting data items.
This environment is used for rating and/or SRP management. Each database connection will
have a logical environment.

Related Documents

For more information, refer to the following Oracle resources:

The Oracle Insurance Insbridge Enterprise Rating Operating Environments for Hardware and
Software.

You can view this guide on-line at this address:

http://www.oracle.com/technetwork/documentation/insurance-097481.html

Manual History

New editions incorporate any updates issued since the previous edition.

Publication Product

Edition : Publication Date Comment
Number Version
~1% Edition P01-788-01 May 2011 Initial Release
2" Edition P01-788-02 R 45.1 September 2011  Update
3" Edition P01-788-03 R 4.6 May 2012 Update
4" Editon  P01-788-04 R 4.6.1 November 2012  Update
5" Editon =~ P01-788-05 R 4.7.0 September 2013 Update
6" Editon  P01-788-06 R 4.7.1 November 2013  Update
7" Editon ~ P01-788-07 R 4.8 August 2014 Update
8" Edition P01-788-08 R 4.9 December 2014 Update
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Chapter 1

SYSTEM UPGRADE REQUIREMENTS

Prior to upgrading an Insbridge system, please have ready:

The Insbridge User Account information.
The location of the current Insbridge installation.

The Insbridge User has administrative rights or proper permissions to run an installation and start
the Insbridge Message Service and the Insbridge Task Manager Service.

You must run as Administrator for a Windows 2008 Server upgrade.
Administrator User name and password for RateManager.
OR

Access to the Insbridge databases. Updates are run against the IBRM and the IB_CLIENT
databases. SoftRater databases may not require an update.

Subscriber, database, and environment information.

Oracle Software Delivery Cloud

Prior to installation, please make sure the source machine(s) where Insbridge will be loaded has an unzip
utility. An unzip utility for most platforms is available on the Oracle Software Delivery Cloud download

page.

Documentation from Oracle Software Delivery Cloud is in PDF format. Prior to installation, please make
sure the source machine(s) where Insbridge documentation will be loaded has a PDF reader.

Files are downloaded with part numbers as file names. Please make note of the part numbers you have
downloaded and the corresponding file name. You may be asked to provide the part numbers or the
filename if you contact Oracle Insurance Support.

The installation downloads you can select are:

Insbridge Install: Required for all RateManager installations. The Insbridge installation is for a
64-bit system.

SoftRater for WebSphere: Required if you are using WebSphere
SoftRater for WebLogic: Required if you are using WebLogic
SoftRater for JBoss: Required if you are using JBoss

Documentation: It is recommended that you download the documentation. Installation guides
and user guides are located here.

11



Chapter 1 — System Upgrade Requirements

The 04.09.00-Insbridge-Insbridge folder contents:

Databases
¢+ DB2

SoftRater: IBSR
o DDLs
o0 Update: usp_IBSR_v04.07.00.db2

¢ Oracle

SoftRater: IBSR
o DDL
0 Update: usp_IBSR_v04.07.00.oracle

¢ SQL Server

RateManager: IBRM
0 Latinl_General_BIN
» DATABASE_BACKUP_IBRM_TEMPLATE_CASE_SENSITIVE.bak
0 SQL_Latinl_General CP1_CI_AS
= DATABASE_BACKUP_IBRM_TEMPLATE.bak
Security: IB_CLIENT
0 SQL_Latinl_General_CP1_CI_AS
= DATABASE_BACKUP_IB CLIENT _TEMPLATE.bak
SoftRater: IBSR
0 Latinl_General BIN
» DATABASE_BACKUP_IBSR_TEMPLATE_CASE_SENSITIVE.bak
0 SQL_Latinl_General CP1_CI_AS
= DATABASE_BACKUP_IBSR_TEMPLATE.bak
0 Update: usp_IBSR_v04.05.01.sql
o0 Update: usp_IBSR_v04.06.00.01.sql
0 Update: usp_IBSR_v04.08.00.00.sql

IE7_IE8 Users
¢ Insbridge RateManager Setup Document PDF
¢ RateManager_ IE7_IE8.exe

Oracle Bl Publisher

¢ OBI_PUBLISHER.exe

Oracle Client

¢ Oracle_client.exe

Oracle Insurance Insbridge Enterprise Rating.exe

The 04.09.00-Insbridge-jboss folder contents:

IBSS.EAR
Insbridge.net.softraterconfig.xml

The 04.09.00-Insbridge-was folder contents:

IBSS.EAR
Insbridge.net.softraterconfig.xml

12



The 04.09.00-Insbridge-wbl folder contents:

- IBSS.EAR
- Insbridge.net.softraterconfig.xml

SoftRater can be installed any time after the Insbridge Framework Administrator and RateManager have
been installed. SoftRater must be installed prior to any users creating packages. Please note, all folders
and files may not be needed, depending upon the kind of setup you want.

ADMINISTRATIVE USER ACCOUNTS

No administrative account is created when Insbridge is installed. An administrative user account must be
created on the server where the Insbridge system is going to be installed. This required account is the
Insbridge Local User Account.

The Insbridge Local User needs to be a member of the User group and requires certain privileges in order

to fully control the entire Insbridge environment. For ease of installation and if the server is dedicated to
the Insbridge Enterprise Rating System, this user can be added to the local machine Administrators

group.

FILE PERMISSIONS

The Insbridge User requires read/write permissions on:

e The Windows Temp Folder. This is necessary for MSMQ.

e The Insbridge Application Pool Identity

e The Insbridge Folder

The Insbridge user must also be given full control over the following registry key:

e HKEY_LOCAL_MACHINE/SOFTWARE/Insbridge

Extended Permission Required by the Insbridge User

In order to start the Insbridge services from IBFA, the Insbridge user must be given full access to both the
Insbridge Message Service and the Insbridge Task Manager Service. If the Insbridge user account will
not have full administrative permissions on the server where the Insbridge Framework is installed, then
certain operations from IBFA will not be available. A system administrator may be required to start the
Insbridge services from the server.

13



Chapter 1 — System Upgrade Requirements

Insbridge User Password

The password can be set to any password that meets your company standards. The Insbridge
administrator must make note of the password for future configuration.

For ease of maintenance, the Insbridge user should not have to change the password and the password
should never expire.

The installation automatically applies the Insbridge user name and password to the necessary libraries,
virtual directories and, if used, Internet Proxy settings in IBFA. If you change the Insbridge user password,
you will have to change the password in all three of the Insbridge Com+ libraries, all three of the Insbridge
virtual directories and, if you are using it, the Internet Proxy settings in IBFA.

NOTE: Please note that if your company requires passwords to be re-set, you will have to make changes
to the COM+ Application libraries, virtual directories and if you are using it, the Internet Proxy
settings in IBFA after you change your password. You also may re-install the application. This
recreates the COM+ applications, virtual directories and IBFA instance with the updated Insbridge
user password. Be aware that re-installing the application may also reset security settings in
IBFA.

Installer Permissions

The installation program requires that the installer have administrator rights on the machine where the
install is occurring. The install must be run as administrator.

NOTE: If the Installer has permissions, an Insbridge User account can be created from within the install.
If you create an Insbridge user from the install, you may not be able to set the permissions you
need. Please be sure to verify the proper permissions are in place before continuing.

Application Server Permissions

WebLogic, WebSphere, and WebLogic require read/write permissions on the server and the application
to create Insbridge specific folders, edit configuration files, and write log files.

DATABASE USER ROLES AND PERMISSIONS

If a more granular approach is required for management of security of the Insbridge databases, then the
following guidelines can be used to set permissions.

NOTE: These are only guidelines. If not properly configured, certain processes within the Insbridge
Enterprise Rating System will fail. An experienced database administrator’'s expertise is highly
recommended before making any security changes.

14



Recommended RateManager Permissions:

It is recommended that the IBRM and IB_CLIENT database user have:

e A database owner (db_owner) role. db_owner access is needed to execute the Insbridge
stored procedures and have full access to the Insbridge schema.

e Disk Admin permissions are also recommended in order to create backups within
RateManager.

For the IBRM and IB_CLIENT databases, if db_owner permissions are not possible, the database will

need to be updated manually. If disk admin permissions are not allowed, backups will have to be done
outside of RateManager.

Recommended SoftRater Permissions:

The recommended permissions are required for new tables to be created in the SoftRater (IBSR)
database dynamically when or if a new line of business SRP (SoftRater Package) is loaded to the
SoftRater system. If the recommended permissions are not possible, manual steps will need to be
performed that will allow for packages to be loaded.
SoftRater can utilize three database types, SQL Server, DB2 and Oracle.
e Insbridge SoftRater SQL Server Database.
It is recommended that the Insbridge login be granted permission to connect to the database
engine and be enabled. It is also recommended that the Insbridge login be mapped to the
Insbridge database with the db_owner role checked.

e Insbridge SoftRater Oracle Database.

It is recommended that the Insbridge user be granted, as defaults, the “CONNECT” and
“RESOURCE” Roles.

e Insbridge SoftRater DB2 Database.

It is recommended that the Insbridge user be granted, as defaults, the “Connect to database”,
“Create Tables”, and “Create packages” authorities.

It is recommended that the databases be on separate machines from the applications due to performance

and security issues. The IBRU applications and databases can be tenants in a larger setup. No known
conflicts exist between IBRU and other applications or required server settings.

It is recommended that db_owner permissions be given to the Insbridge user. This will allow scripts to be

run automatically when a new package is loaded for a new line of business. If this is not possible, DT
scripts for each new line will have to be run manually before the package can be loaded.
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Microsoft SQL Server

JDBC Driver Class

“com.microsoft.jdbc.sqlserver.SQLServerDriver”

Supported Versions — 2008 R2 and 2012

User Account Requirements

Create Table
Create Index
Execute on the SoftRater User Defined Stored Procedures

Oracle

SoftRater database schema is support by all available ORACLE database platforms.

JDBC Driver Class

“oracle.jdbc.driver.OracleDriver”
Using prefix jdbc:oracle:thin:

Supported Versions — 10g, 119, 12c

User Account Requirements

Create Table
Create Index
Query access to “SYS.0OBJ$"

IBM DB2

SoftRater database schema is supported on version 9.7.

JDBC Driver Class
“com.ibm.db2.jcc.DB2Driver”
For Native AS400 — “com.ibm.as400.access.AS400JDBCDriver”

Supported Version — 9.7

User Account Requirements

Connect to database

Create Table

Create Packages

Query access to “SYSIBM.SYSTABLES”
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Configuration Settings

Required

The query dynamics of the SoftRater system requires some modification to Configuration
settings. The following Performance Configurations parameters required to the target SoftRater
database.

Instance Level — ASLHEAPSZ >= 1024

Instance Level - QUERY_HEAP_SZ => 10240

Database Level - APPLHEAPSZ >= 1024

Recommended

The query dynamics of the SoftRater system will benefit from the following modification to
Configuration settings.

Instance Level — INTRA_PARRALLEL (Yes) — For Symmetrical Processing Machines (CPU >=2)

Database Level — DFT_DEGREE (-1) — For Symmetrical Processing Machines (CPU >=2). Allow
the optimizer to determine the degree of intra-partition parallelism based on the number of
processors and the type of query.
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Quick View

UPGRADING RATEMANAGER, IBFA AND SR-WIN

NOTICE: Release 4.9 has a new system requirements and a new file structure. The release 4.9 files will
be placed in a different location on the server from previous releases. This change requires
subscriber, database, and environment information to be re-entered either manually or by
copying and placing previous config.xml files to a new location.

A new application pool will also be created. This may require updates to any service or web site
that calls the Insbridge application. If the Insbridge portal is being used, updates will need to be
made there as well.

The machine where Insbridge is located needs to be rebooted prior to upgrading. Rebooting is
necessary to assure that com+ settings are properly updated, Insbridge services are properly
stopped and all users are logged off.

Windows should be up and running prior to upgrading.

This update takes RateManager and the corresponding IBFA to release 04.09.00.

Steps to Upgrade RateManager/IBFA:

Every upgrade requires:

e Step 1: Verify or Install .NET 4.5.
e Step 2: Reboot system.
e Step 3: Run the Insbridge exe to update the application.
e Step 4: Verifying the Insbridge Application Pool.
e Step 5: Enter IBFA and Configure:
- Subscriber
- Database connections
- Environment
e Step 6: Installing the OBI Publisher.
e Step 7: Start Insbridge Message Service.

e Step 8: Run the required SQL script manually on the SQL Server database. SoftRater database
updates are not available from RateManager.

e Step 9: Update Preferences.

NOTE: Updates to the databases can be performed manually, if desired. Manual updates are performed
directly in SQL Server.
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Additional Step to Upgrade RateManager/IBFA:

You also will need to run this step if you want to make previous workfiles available to users

This procedure takes RateManager and the corresponding IBFA to release 04.09.00 and assures that
previous workfiles are available to users.

e Step 1: Migrate Workfiles.
e Step 2: Update Portal URL.

Steps to Upgrade SoftRater for Windows from a Previous Release:

This procedure takes a SoftRater for Windows node from a previous version to release 04.09.00. This
setup must utilize SQL Server.

e Step 1: Verify or Install .NET 4.5.
e Step 2: Reboot system.
e Step 3: Run the Insbridge exe to update the application.
e Step 4: Verifying the Insbridge Application Pool.
e Step 5: Enter IBFA and Configure:
- Subscriber
- Database connections
- Environment
e Step 6: Installing the OBI Publisher.
e Step 7: Start Insbridge Message Service.

e Step 8: Run the required SQL script manually on the SQL Server database. SoftRater database
updates are not available from RateManager.

e Step 9: Update Preferences.
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Chapter 2

UPDATING AN INSBRIDGE APPLICATION

NOTICE: Release 4.9 has a new system requirements and a new file structure. The release 4.9 files will

be placed in a different location on the server from previous releases. This change requires
subscriber, database, and environment information to be re-entered either manually or by
copying and placing previous config.xml files to a new location.

STOP:

For Release 4.9, .NET 4.5 is REQUIRED. DO NOT RUN the Insbridge executable prior to
verifying .NET4.5 is installed.

.NET 4.5 is not included with the Insbridge installation. The .NET 4.5 download can be obtained
from Microsoft.

This procedure takes RateManager and the corresponding IBFA to release 04.09.00.

Step 1: Verify or Install .NET 4.5.
Step 2: Reboot system.
Step 3: Run the Insbridge exe to update the application.
Step 4: Verifying the Insbridge Application Pool.
Step 5: Enter IBFA and Configure:
- Subscriber
- Database connections
- Environment
Step 6: Installing the OBI Publisher.
Step 7: Start Insbridge Message Service.

Step 8: Run the required SQL script manually on the SQL Server database. SoftRater database
updates are not available from RateManager.

Step 9: Update Preferences.

NOTE:

Updates to the database can be performed manually, if desired. Manual updates are performed directly
in SQL Server.
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STEP 1 — VERIFY OR INSTALL .NET 4.5

.NET 4.5 requires .NET 3.5.1 features to be installed prior to installing .NET 4.5. Failure to use .NET 4.5
results in errors when accessing IBFA.

1. Select Start->Administrative Tools—> Server Manager.

2. Select Features Summary. Scroll through the list to verify .NET Framework 3.5.1 Features has
been installed.

. Server Manager

I[=1 E3
File  Action ‘iew Help
b A Ealll 7|

5 Roles

Eﬂ Features
m Diagnostics : ‘iew the status of Features installed on this server and add or remave features,
Gt Configuration 2

=5 Storage

*! Features Summary E Features Surmary Help

~| Features: 3 of 42 installed A Add Features
f_ﬁ. Remove Features
Remaote Server Administration Tools
Role Administration Tools
‘Web Server (I115) Tools
Windows Process Ackivation Service
Process Model
MET Enwironment
Configuration APTs
\MET Framework 3.5.1 Features
JMNET Frameveork. 3.5.1
WCF Activation
HTTP Activation

%:‘. Last Refresh: Today at 9:42 &M Configure refresh

Figure 1 Verifying .NET Framework 3.5.1 Features

3. If not, select Add Features. The Add Features Wizard is displayed.

4. Select .NET Framework 3.5.1 Features. Click Next.
5. Confirm your selection and click Install. The installation will proceed.

You can close out when complete. To assure the registry gets updated with the .NET Framework
3.5.1, restart the system.

After you have verified the .NET Framework 3.5.1 Features, verify that .NET 4.5 has been
installed by opening the registry file.
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8. Select Run from the Start Menu.
9. Type regedt32. Click OK. The Registry Editor will open.

10. Browse to HKEY_LOCAL_MACHINE->SOFTWARE->Microsoft2>.NET Framework
Setup2>NDP>v4->Full.

£ Registry Editor

File Edit View Favorites Help

[ L MMC ;I Mame | Type | Data |
H- . Mobile ab](Default) REG_SZ {value not sek)

- | MSBuild 4| Install REG_DWORD 000000001 §1)

| JJ MSDE ab|InstallPath REG_SZ CivindowsiMicrosoft, NET|Frameworkadiv4.0,30319,

)

)

)

| MSDTC 28\ ms1 REG_DWORD 0x00000001 (1)

y MSFo 7| Release REG_DWORD 0x0005ckFS (379893)

. Malicensing 48| Servicing REG_DWORD 000000000 ()

----- ] ab ion BEG.S S0

] | MSSQLServer ab]'v'ersion REG.57 4551209'
[ NaEserver

[~ . MET Framework Setup

B~ | NDP

H | CDF

Bl | w2.0,50727

o w30

o
. w35
W

=

, Client

B £
[+- . w40
""" . Metsh
- | Mebwork,
- | MetworkAccessProtection
----- . Mon-Drriver Signing
£ . Motepad
H- ) ODBC
- | Office
H- ) Ole
£ Outlook Express
H- [ PLA
#]- | PowerShel
£+ [ Print
]
]
]
]
al
]
al

W0 O B B B e

-

-
ST

. RADAR

. Ras

| Reliability Analysis
| RemovalTools

. RFC11564gent

. Router

im0 O e O e O O e O O O s O O O O e O e

- | Rpc =
Bl b

|C0mputer'l,HKE\"_LOCAL_MACHINE'!,SOFTWARE'l,MicrosoFt'l,NET Framework. SetupiWDPw4Full 4

Figure 2 Verifying .NET 4.5 in Registry

11. The version should read 4.5. If v4 is not listed or the Full folder is not present, .NET 4.5 has not
been installed. Make sure to look at the v4 folder. DO NOT look at v4.0.

12. If .NET 4.5 is installed, close out the registry and continue.

13. If .NET 4.5 is not installed, you must install before you can continue. .NET 4.5 must be installed
prior to running the Insbridge installation.

NOTE: .NET 4.5 is not included with the Insbridge installation. The .NET 4.5 download can be obtained
from Microsoft.
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Troubleshooting

If you receive an error when accessing IBFA:
Could not load type "System.ServiceModel _Activation._HttpModule® from

assembly "System.ServiceModel, Version=3.0.0.0, Culture=neutral,
PublicKeyToken=b77a5c561934e089

This error may happen when there are multiple versions of .NET Framework on a machine that is running
IIS and did not get registered properly.

Please see http://msdn.microsoft.com/en-us/library/hh169179(v=nav.71).aspx for more information.

STEP 2 — REBOOT SYSTEM

The machine where Insbridge is located needs to be rebooted prior to upgrading. Rebooting is
necessary to assure that com+ settings are properly updated, Insbridge services are properly
stopped and all users are logged off.

Windows should be up and running prior to upgrading.
If the Insbridge Message Service is set to automatic, you must stop the service prior to running the install.

Failure to stop the Insbridge Message Service may result in the upgrade not completing properly.

Failure to Shut Down Com + Services:

Failure to shut down Com + Services may result in a configured identity error message when users
access RateManager. Users may receive an error message that an incorrect username and password are
being used or remote access is not allowed.

To correct reboot the server where the Insbridge System was installed. When Windows is up and running,
run the Insbridge executable to remove the Insbridge system. Rerun the Insbridge executable again to re-
install.

To verify Com+ was updated, enter Com+ and verify the Identity of each of the Insbridge Com+ Services
is the Insbridge user. The Identity can be found on Properties->Identity.

NOTE: The Insbridge Com plus services are started when users access the system.
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Failure to Shut Down Insbridge Message Service:

Failure to shut down the Insbridge Message Service may result in an error message being displayed
during installation and failure to completely install the required Insbridge executable. The best way to
ensure the Insbridge Message Service has completely shutdown is to reboot the system.

i'é'a Oracle Insurance Insbridge Setup | x| |
Files In Use ORACLE

Saome filez that need ta be updated are currently in use. INSURANCE

The fallowing applications are uzing files that need ta be updated by thiz zetup.

Inshridge hMessagellueue Senice

&+ futomatically close all applications and attempt to restart them after setup is complete.
" Do not cloze applications. [& reboot wil be required. |

YWize Installation Wizard [R]

Cancel |

Figure 3 Insbridge Message Service Running During Update

Failure to Use Correct Install Package:

Failure to run the correct installation package will result in an error message. To correct, download the
installation package for the machine you have.

i't‘!:l‘ Installer Information |

Pleaze inztall the Inzbridge Rating and Undenariting =64
ifztalation far B4 bit platfarms.
g

Figure 4 Failure to User Correct Install Package
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STEP 3 — RUNNING THE INSBRIDGE APPLICATION

An update to the Insbridge system is run from the Oracle Insurance — Insbridge Enterprise Rating.exe.
Unzip the Insbridge folder on the machine where the Insbridge system (IBFA and RateManager) is
currently installed.

STOP: For Release 4.9, .NET 4.5 is REQUIRED. DO NOT RUN the Insbridge executable prior to
verifying .NET4.5 is installed.

.NET 4.5 is not included with the Insbridge installation. The .NET 4.5 download can be obtained
from Microsoft.

1. Begin with the Oracle Insurance - Insbridge Enterprise Rating Install file.

2. Open the Oracle Insurance — Insbridge Enterprise Rating file. A Welcome screen is displayed.

fit Oracle Insurance Insbridge Setup I =] |

4 Oracle Insurance Insbridge

[t iz strangly recommended that you exit al Windows programs befare running this setup program.

Click. Cancel ta quit the setup program, then cloze any programs pou have running. Click Mest to
continue the installation,

WARMIMG: This program is protected by coperight law and international treaties.

Unauthorized reproduction or diztribution of this program, or any portion of it, may result in severe
civil and criminal penalties, and will be prozecuted ta the maximum extent poszible under law.

ORACLE’
INSURANCE

¢ Back

Cancel |

Figure 5 Installing Insbridge

3. Click on Next to continue.
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fit Oracle Insurance Insbridge Setup I =] |
Destination Folder DRACLE'
Select a folder where the application will be installed.
PR INSURANCE

T he Wize Installation ‘wfizard will inztall the files for Oracle Insurance Inzbridae in the
following falder. An upgrade or a patch will install the application o the previous
inztallation path.

Y'ou can choose nob ta install Oracle Inzurance [nsbridge by clicking Cancel to exit the
Wize [nstallation ‘wizard.

CAPROGRAM FILESAORACLEMGRUMMSEBRIDGEY

" Destination Folder

YWize Inztallation Ywizard [R]

Figure 6 Destination Location for Update

4. The destination path is displayed next. This is an information only screen. No changes are allowed.
Click Next.
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fit Oracle Insurance Insbridge Setup I =] |

Logon Information DRACLE‘

The following logon information is uzed by Insbridge. INSURANCE

Specify a uzer account bo be wzed by the application, either far running a service ar for
logging onto other servers. Uze the Browse button to chooze wzers from pour nebworl:.
Far domainz, user names must be in the format of DOMAINW ] zerM ame.

User Mame: |insl:uriu:|ge Browsze. .. |

Pazzword: I [ IITTTYTY]

Create Mew zer..

YWize Inztallation YWizard [R]

< Back

Cancel |

Figure 7 Entering User Information for Insbridge

5. The next screen is the Logon Information screen. Please use the Insbridge user account information

that you set up for the initial installation. Click Next to continue.
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fit Oracle Insurance Insbridge Setup I =] |

Select Features C}RACLE‘

Pleaze select which features you would like toinstall. INSURANCE

Feature Description:

Oracle Inzurance Insbridge is a Web-based
rating, rules, and undenariting system,

- = 'I Qracle Bl Publizher A eports

Thiz feature will be inztalled on the lacal hard
drive.

| iz heature requires UKE an your hard drve. |t
haz 2 of 2 subleatures zelected. The
subfeatures free up B085KE on vour hard
drive.

Inztall location:
C:A\FPROGRARM FILESSORACLENGEUSMSERIDGEY

YWize Inztallation Ywizard [R]
Digk Cozt Reszet

Figure 8 Selecting Features to Install

6. The next screen lists the applications to be installed. To expand the options and view detalils, click on
the downward arrow. All features are checked for installation. RateManager is the only one that you
will be allowed to not install. Click Next.

Options are:

e Oracle Insurance Insbridge:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

e RateManager:
- The default option is: Entire feature will be installed on local hard drive.
- You will be able to opt out of this option. Select Entire Feature will be unavailable.
RateManager will not be installed.

NOTE: Do not install this option for SoftRater for Windows (SoftRater Node) updates.

e IBFA:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

e Oracle Bl Publisher Reports:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

This option does not install the OBI Publisher. Only the templates required by the Insbridge application
will be installed on local hard drive.
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jig Oracle Insurance Insbridge Setup M= E3 |

Ready to Install the Application ORACLE

Click, Mext to begin ingtallation. INSURANCE

Click the Back button to reenter the installation information or click Cancel to exit
the wizard.

wize Inztallation \wizard [R]

Cancel |

Figure 9 Ready to Install

7. A Ready to Install screen is displayed. If you are ready, click Next. Otherwise click Back to check the

options you want to install. A progress screen displays your progress.

ji Oracle Insurance Insbridge Setup M=l B |

Updating System ORACLE

The featuresz you selected are currently being installed.
¥ ¥ hEnd INSURANCE

Yalidating prerequisites. ..

Time remaining: 13 seconds

Wize Installation Wizard [R]
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NOTE: If you receive a message that the system will need to be rebooted after the installation, STOP
THE INSTALLATION. This message means that the Insbridge Com + services are running. If
you get this message:

1. Stop the Installation.
2. Reboot the server.
3. Start the Installation over.

4. If the Insbridge Message Service is set to automatic, you must stop the service prior to running

the install.

8. When complete, a ReadMe Information screen is displayed.
fii Dracle Insurance Insbridge Setup ™ =] |

4 Oracle Insurance Insbridge

Click the Finish buttaon to exit this installation.

ORACLE’

INSURANCE

Canzel |

¢ Back

Figure 10 Completed Installation

9. Click Finish to finish the installation. The installation should complete successfully.
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STEP 4 — INSBRIDGE APPLICATION POOL

Insbridge requires .NET framework setting of v4.5. This may present conflicts with other applications in

the default application pool that require a different setting. To avoid conflict and improve performance, a
separate Insbridge Application Pool must be used.

The previous Insbridge application should not be used.

Verify the Insbridge Application Pool

A default Insbridge Application Pool is created at installation. This pool ORACLE_FSGBU_INSBRIDGE

should be used for the Oracle applications. Please verify that the Insbridge web applications are
associated with the new Insbridge application pool.

1. Click Start > Administrative Tools = select IIS Manager.
2. Expand the Local Computer and select Application Pools. Verify the

ORACLE_FSGBU_INSBRIDGE application pool, the Identity is Insbridge and that there are 3
applications associated. If the pool is correct, proceed to the next step.

"-’EInternet Information Services (IIS) Manager == 3

@ 3] [ P v SERVER b Application Pools & M@ -

Fle ¥iew Help

ST G%l Application Pools

.;, Add Application Poal...
5 Start Page

Set Application Pool Defauls. ..
- SERVER This page lets you view and manage the list of application pools on the server, Application pools are associated with worker S AP O
ﬂ 2 Bpplication Pocls processes, conkain one or move applications, and provide isolation among different applications, Application Pool Tasks
s
B-[aj skes Filker: v [l Go - g show Al | Group by: Mo Grouping - P Shart
-|-&(3) Default veh Sit
= _ ° ZL; nete ch;:t Mame = [ Status [ .MET Frame... I Managed Pipeli. .. | xdentit |_Applications | 8 sop
FY IBEA - QASP.NET w0 Started w40 Integrated ApplicationPoollden... 0 o Recycle.,
5 Y . N N
insbridge = ASP.NET w40 Classic Started w40 Classic ApplicationPoolIden.. . Edit Application Pool
WSO ,;‘.‘Classlc NET AppPaol Started w20 Classic

|:| Basic Settings. ..
Recyeling. ..

RM L} DefaultappPool Started wz.0 Inkeqgrated
ORACLE_FSGEL_INSERIDGE Started

ApplicationPoolIden. ..
Integrated Inshridge

o
applicationPoollden.,. 0
z

Advanced Settings, .,
Rename

K remove

View Applications

-291‘ Help

Online Help

Ready

If the ORACLE_FSGBU_INSBRIDGE has not been created, you will have to create one. Please see
Appendix A, Creating an Application Pool.
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STEP 5 — CONFIGURING INSBRIDGE FRAMEWORK ADMINISTRATOR

NOTICE: Release 4.9 has a new system requirements and a new file structure. The release 4.9 files will
be placed in a different location on the server from previous releases. This change requires
subscriber, database, and environment information to be re-entered either manually or by
copying and placing previous config.xml files to a new location.

USING PREVIOUS CONFIG.XML FILES

If you do not want to re-enter IBFA information, you can copy and paste the previous config.xml file from
the old location to the new location.

Step 1: Copy the Previous Insbridge. XML File

You can copy and paste the Insbridge XML file from the old machine to the new machine. This will allow
the environments and subscriber created in the old machine to be populated in the new machine.

NOTE: If you want to re-enter or re-create your environments, you can skip Step 4 and Step 5. After you
import the registry key, you will need to continue the RateManager/IBFA installation at Step 7 —
Configuring Insbridge Framework Administrator.

File Location:

The location of the Insbridge. XML file to be copied will depend upon what version of RateManager the old
machine is running. There are two possible locations.

For Release 3.12 and earlier:
e File Name: InsBridge.XML
e Location: D:\ProgramFiles\InsBridge\Framework\2.0.2\InsBridge.Xml.
OR C:\Program Files\Oracle\Insbridge\Framework\2.0.0\insbridge.Xml

For Release 3.13 and later:

e File Name: InsBridge.XML
e Location: C:\Program Files\Oracle\IGBU\Insbridge\Framework\3.5.0\insbridge.Xml

Copy the Insbridge. XML file to a location you can easily access.

NOTE: If you are changing databases, you can copy and paste the Insbridge XML file, however you will
need to update your environments with the new database information.
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Figure 11 Previous Config.xml file Location

Step 2: Paste the Insbridge. XML File

Before pasting the Insbridge. XML file into the new location, make a copy of the blank Insbridge. XML file
and store in a safe location. In the unlikely event that an error occurs, you will have a backup file that you
can use.
The Insbridge. XML file in the New Machine is located:
C:\Program Files\Oracle\Insbridge\Framework\4.5.0\insbridge.Xml

1. Make a copy of the blank Insbridge.XML file on the new machine and store in a safe location.

2. Paste the Insbridge.XML file from the old machine in to the new machine in the same location.

3. Open an Internet Explorer web browser either remotely on the local Insbridge web server and
browse to IBFA location on the new machine: http://SERVERNAME/ibfa/

4. Subscribers and Environments should be available in IBFA on the new machine. Verify your
entries.
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. Framework || Insbridge. Net. Engine. R1Hb 12/29/2014 9:23 AM  TLEFile 17 KB
§ 3.5.0 % Insbridge Net, Fwk, dil 12/20/2014 z:00 AM  Application extension 454 KB
: ?::h ) Insbridge Met. Fwk, dil. config 12/17[2014 1:59 PM CONFIG File 1KB
| GruPG || Inshridge Met. Fuk.th 12/28/2014 9:23 AN TLE File 43 KB
. OB % Insbridge Met.Licensing.dll 10/20/2014 3:55 PM Application extension 28 KB
. odac_insbridge % Insbridge Net. ProgramReportsEngine. dil 12/13/2014 12:52 &M Application extension 120 KB
. oracle_dataaccess_set % Inshridge. Met.RM. Packaging.di 121182014 £:02 &M Application extension 139 KB
+ Reports Insbridgs. Nk, Spoke. Inkerface. dI 10{22/2014 7:06 &M Application sxkension 16 KB
1 SD;KTBmp Inshridge. Net. spoke. Interface. th 11/21/2014 3:11 PM__ TLEFile 5 KB .
T st 11 New Location
. Webs = InsBridge_Copy . xml 12[8(2014 9:33 AM ML Document KB
. Insbridge [ InshridgeLibsComPlusRegister exe 12§20/2014 2:37 PM  Application 37 KB
CoM+ install_cracle_client_for_insbricige. bat 12/29/2014 9:23 A Windows Batch File 1KB
Framesork T [Einskaltiexe 9112013 6:39 M Application 40 KB
: 4‘2'? " L Installukl. InstallLog 12/29/2014 9:23 AM INSTALLLOG File 11 KB
| Fop = MessageService exe 12/13/2014 3:54 &M Application S2 KB b
| GruPs | MessageService, exe,config 10/17/2014 6;13 AM  CONFIG File 2 KB
. OBI | MessageService. InstallLog 12/29/2014 23 AM  INSTALLLOG File TKEB
. odac_insbridge || MessageService InstallState 12/29/2014 9:23 &M INSTALLSTATE File FKE
. oracle_dataaccess_setuf =] MessageService, xm 12/29/2014 9:23 M XML Document 3KE
- Reports LI MessaneServire v A FIPNNG #:31 AM %50 File A KR ﬂ
<> InsBridge. Xml Date modified: 12/5/2014 4:00 PM Date created: 11/21/2014 3:11 FM
*ML Documnent Size: 7,86 KB

Figure 12 New Config.xml File Location
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Logging in to IBFA

If you have elected to re-use an existing config.xml file, IBFA should be populated with the same
information as the previous Insbridge instance.

If you want to re-enter the information, IBFA will be blank.

Open an Internet Explorer web browser and browse to the following location, replacing SERVERNAME
with the actual server name:

http://SERVERNAME/IBFA

The default security setting for a new installation is Custom and requires a login to access.

Q@ @ http://localhost/IBFA/ L-2¢ @ Framework Administrator (... *

ORACL_E" msurance Insbridge Framework Administrator Version 04.00.00 (x64)

B Show FrameworkAdmin Menu

Explorer not configured. Please contact your system administrator.

Click “Show FrameworkAdmin Menu”
\ to display login options.

Figure 13 IBFA Landing Page

1. IBFA requires a login to access. Click the Show FrameworkAdmin Menu link to display the login.
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() & http://localhost/IBFA/

o

F=EEERX
p-2e

ORACLE msurance Insbridge Framework Administrator

[x]

Ezplorer not configured. Please contact yeur system administrator

4 Access Secure Services

User 1Dz
Password:

Figure 14 IBFA Login Screen

2. Enter the default User ID and password:

User ID: admin
Password: insbridge

3. The IBFA home page is displayed.

Updating IBFA Security

Wersion 04.09.00 (x64)

4. Itis recommended that you change the login password immediately. You do not have to change

the password.

5. On the left side menu, select Security-> Change Password.
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= Insbridge
- SoftRater
- SoftData
-l Services
[#-_J Logs
- Security
£
-8 softlibraries
@) Help

Change 'Custom Security’ Admin Password

Insbridge suggests that you use a password that is 6-8 characters lang. If you think someaone else knows the admin
password, please contact your system administrator.

Old Password
New Password

Confirm Password

Update

Figure 15 Updating the Default Password

6. Enterin the default password for the old password and enter in the new password of your choice.
Confirm the new password and click Update. A success message is displayed when the admin
password is updated. If an error message is displayed, make corrections and try again.

7. If you do not want to require a login, you can change the security to None. This changes the
default landing page to the IBFA home page and removes any login requirements.

8. On the left side menu, select Security.

9. Select None for Framework Administration Web Security for no security. The landing page will be
updated the IBFA home page and no login will be required.

=3 Insbridge

- SoftRater

- SoftData

- Services

- Logs

=B

.__.I Change Password

423 Softlibraries

- @) Help

Framework Administration Web Security

To utilize Windows authentication please select the Windows security option and contact your system administrator to
update your IIS settings. The Insbridge Custom Forms authentication requires that you enter an admin user and password
combination for web access.

) None
) Windows
® Ccustom

[] Allow unauthorized users to view secure environments? {read-only)

External APT Access

The Insbridge Framework Administrator has an open API for back-office system automation. To allow an external process
to connect to this node, enable and set the access key below.

() Disabled

(@ Enabled |ce8de543-00d5-4bd3-37ca-f431b6237573 Generate Key

Figure 16 Selecting Security for IBFA

NOTE: You also can select to use Windows security. Please see the IBFA user guide for more
information on setting up Windows security.
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Entering Company Information

If you have elected to re-use a previous config.xml file, you may skip to the next step.

Prior to users entering RateManager, the Insbridge Framework Administrator must be configured for your

company.

.

[PEmEERTC)

e B ‘@ http://localhost/IBFA

o-2c|

[x]

B8] sbricoe |

+- SoftRater
{3 SoftData
[ Services
+-4 Logs

- Security
4% Softlibraries
@) Help

ORACI_E‘MSurance Insbridge Framework Administrator

Version 04.09.00 (x64)

Confiquration File [C:\PROGRAM FILES|ORACLE\TNSBRIDGE | FRAMEWORK\4.5.0\Inshridge.Xml]

The Framework Administrator Web will configure any Insbridge Framework Configuration file (Insbridge. xml) found on your
network. Although all Insbridge Applications may have their own version of this configuration file, we suggest that all apps
that reside on the same Framework Server share the same file.

Change Config File location: Edit| | Apply

Click on "Edit” button to enable the text box above. Copy and paste the new Insbridge XML file location in the text box.
Then diick on "Apply™ button to apply the new configuration file.

Add Subscriber

The subscriber identifier is an unique number that you would like to represent your company. Please consult with an
Insbridge support representative if you have any questions.

Click on the id of the subscriber in the list to edit.

# No Subscribers found.

Add Database Connection

Create or edit database connection. This database connection can be global to the Insbridge Framework or unique to the
Subscriber.

Click on the name of the connection to edit.
€2 Global

# No Connections found.

Copyright © 2000,2009, Oracle andjor its affilates. All ights reserved.

Figure 17 IBFA Home

NOTE: If you receive an access denied error message, please verify that you have given the Insbridge
user full control of the Insbridge folder.

NOTE: If you receive an IDNX denied error message, please verify that the Insbridge user has full control

over the Insbridge directory. Regedt->Insbridge Directory-> Security.

NOTE: If you receive an error regarding MCSiMenuCltl, please verify that you are using Internet Explorer
8.0 or 9.0 (32-bit). Release 04.09.xx does not support Internet Explorer 8.0 or 9.0 (64-bit).

There are five steps that need to be done in IBFA:
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e Step 1. Creating a New Subscriber

e Step 2. Adding a Global Database Connection

e Step 3. Adding a Security Database Connection

e Step 4. Adding an RM security Database Connection

e Step 5: Creating a RateManager Environment

Step 1: Creating a Subscriber:

A subscriber is a group or collective of users and environments under a single identity. This identity is
used to manage and configure the group’s activities and databases. A subscriber may be a single
company, a group within a company, or a single person.

The ID, Name and Description are selected by you. The ID and Name are fixed after the first time you
save. These entries cannot be edited. Only the description can be edited.

1. Click on Add Subscriber on the Main IBFA screen. A separate screen is displayed.
2. Enter the ID, Name and Description for your subscriber.

3. When you finish entering the information, click Save. The new subscriber will now be displayed in
the list of subscribers.

£ | Subscriber -- Webpage Dialog &J

Subscriber
Flease enterfupdate your Insbridge Customer information below.,

ID: 36059
Mame: Alamere

Desc:  Alamere Insurance

Save Cancel

L

Figure 18 Enter ID

NOTE: Make note of the subscriber ID number. You may need to enter this on another IBFA or IBSS
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environment.

The Subscriber ID can be a 1-5 digit number and must unique for each subscriber. For example,
if you have an instance of IBFA on machine A, you can create a subscriber with an ID of 100. On
machine A, if you create another subscriber, you must give that subscriber a different ID number,
say 200. If you also have an instance of IBFA on a different machine, B for example, you should

duplicate the same subscribers with the same ID numbers on machine B.

If you require assistance or are unsure of what action to take, please log a Service Request using
My Oracle Support at https://support.oracle.com/.

Next Step: Add Database Connections:

Stay on the Main IBFA screen. Three databases must be added to IBFA:

Subscriber: Global with Name: controller. This is a global database and is required for logging in
to the Insbridge system. This is not unique to the subscriber.

Subscriber: (Your Subscriber Name) with Name: security. This is a subscriber specific
database and is required for subscriber security information.

Subscriber: (Your Subscriber Name) with Name: RM. This is a subscriber specific database and
is required for RateManager. This information will also be used when creating the RateManager
environment.

The setups are similar for all three databases. The description information following the first example will
be the same for the other two databases.

NOTE: If you have renamed the databases, please make note of the new names.

To continue, you will need to exact names of the databases you restored in Step 5, IBRM_xxxx, and
IB_CLIENT databases.
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Step 2: Adding a Global Database Connection:

Begin by filling out connection information for the IB_CLIENT database using the Global subscriber.

1. From the Insbridge page, click the Add Database Connection link. This opens the Connection

screen.
-
& | Connection -- Webpage Dialog [iF-J
Connection
Database connections can be global to the Insbridge Framework or unigue to the Subscriber.
Subscriber: Global -
Mame:; Controller
Server: LocalHost Test Connection...
Server Type: SQLServer -
Cataloq: IE_CLIENT
Catalog Type: Other -
Query Buffer:
Tablespace:
Schema:
User: 53
Passwaord: TIIIIIL
Save Cancel
e .

Figure 19 Setting up the Global Database Connection

2. Select Global for the Subscriber.

3. Enter Controller for the Database Name. The name must be Controller. This cannot be changed
once you have saved it.

4. The Server is the database server name or IP address whichever is resolvable by the Insbridge
web server. You also can test the connection and make sure it is valid at the time of entry.

5. The DB Server Type is the type of server that houses the database. The controller, security and
rm databases are all SQL Server.

6. Enter IB_CLIENT for the Catalog. This is the IB_CLIENT database you restored in step 5.
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7. Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The
controller and security databases will both be type OTHER. The rm database will be type
RateManager.

8. Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.

9. The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner.

10. Click SAVE to save your work. You will be returned to the main Insbridge page. The controller
database will be listed.

Step 3: Adding a Security Database Connection:

1. Next, add the security database. Select the Add Database Connection link again.

2. Select Your Subscriber. The security database is unique to the subscriber.

& | Connection -- Webpage Dialog [i_E-J

Connection
Database connections can be global to the Insbridge Framework or unique to the Subscriber.

Subscriber: Alamere Insurance -
Mame: Security

Server: LocalHost Test Connection. ..
Server Type:  S0LServer -

Cataloq: IE_CLIENT

Catalog Type: Other -

Query Buffer:

Tablespace:

Schema:

User: 53

Password: I

Save Cancel

Figure 20 Setting up the Security Database Connection

42



Chapter 2 — Updating an Insbridge Application

10.

Enter Security for the Database Name. The name must be Security. This cannot be changed
once you have saved it.

The Server is the database server name or IP address whichever is resolvable by the Insbridge
web server. You also can test the connection and make sure it is valid at the time of entry.

The DB Server Type is the type of server that houses the database. The controller, security and
rm databases will all be SQL Server.

Enter IB_CLIENT for the Catalog. This is the IB_CLIENT database you restored in step 5.
Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The
controller and security databases will both be type OTHER. The rm database will be type

RateManager.

Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.

The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner.

Click SAVE to save your work. You will be returned to the main Insbridge page. The controller
database will be listed

Step 4: Adding an rm Database Connection:

10.

Next, add the rm database. Select the Add Database Connection link again.
Select Your Subscriber. The rm database is unique to the subscriber.
Enter rm for the Database Name. This cannot be changed once you have saved it.

The Server is the database server name or IP address whichever is resolvable by the Insbridge
web server. You also can test the connection and make sure it is valid at the time of entry.

The DB Server Type is the type of server that houses the database. The controller, security and
rm databases will all be SQL Server.

Enter IBRM_xxxx for the Catalog. This is the RM database you restored in step 5.
Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The
controller and security databases will both be type OTHER. The rm database will be type

RateManager.

Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.

The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner.

Click SAVE to save your work. You will be returned to the main Insbridge page. The controller
database will be listed
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& | Connection -- Webpage Dialog [—?hj

Connection
Database connections can be global to the Insbridge Framework or unique to the Subscriber.

Subscriber: Alamere Insurance -
Mame: RM

Server: LocalHost Test Connection. ..
Server Type:  S0QLServer -

Cataloq: IERM

Catalog Type: |(ERIEIEr ol ~

Query Buffer:

Tablespace:

Schema:

User: 53

Password: (TTTYTTTS

Save Cancel

Figure 21 Setting up the RateManager Database Connection

NOTE: The Catalog Type must be set to RateManager when you are creating the Connection from
RateManager. If you leave it set to Other, you will receive an error.

Creating Logical Environments:

Next, create the default rating environment for the RateManager system.
For a new installation it is recommended that you create one logical environment:

e RM: to handle rating and testing.

You can create additional environments at this time if necessary or you can add them in at a later time.

Step 5: Creating a RateManager Environment:

It is recommended that only one RateManager environment be created.
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1. Browse to SoftRater>Explorer>Subscriber name.

< JO)

hitp://localhost/IBFA/default.aspx

0O - B¢ || @ Framework Administrator (... %

File Edit View Favorites Tools Help

ORACLE nsurance insbridge Framework Administrator

[
E-C3 Insbridge
-3 softRater
i [d Engine
i B3 Explorer
----- Alamere Insurance

i~ softData
[ Services
[ Logs

[ security
&= Softiibraries

E@Hﬂp

T ———

prr—

Configuration

Environments

Add, edit, or remove environments from your Explorer configuration.

NAME - DESCRIPTION

# No environments found.

Line-of-Business Management
“Your rating book of businesses are identified by an id and a description. There is na limit to the number of LOB's (ine-of-
business) that your Explorer can contain.

D - DESCRIPTION

# No Lines found.

Yirtual File Server Manangement
There are times when you must download SoftRater packages from different locations. These locations require a domain
name of an ip-address of the particular server.

DESCRIPTION - SERVER - TYPE - ENVIRONMENT

# Mo file servers found.

Version 04.09.00 (x64) l

Figure 22 Create a Rating Environment

2. Click on Add Environment.
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E Environments -- Webpage Dialog -

SoftRater

A SoftRater configuration can support an unlimited number of environments,
Mame: RM
Type: Dev - |
Secure:
| |
T S |

Figure 23 Entering Name and Environment

3. Enter a Name and select a Type. The name and type are totally dependent on how your
Insbridge system is designed.

There are three types of Logical Environments:

e Development
e Quality Assurance
e Production

After you have entered your logical environment, you must define it.

Defining the Logical Environment

ORACL_E msurance Insbridge Framework Administrator

=~ Insbridge
Elﬁ SoftRater
Ej Engine
Eﬁ Explorer Add Environment
FrE——— S e Add, edit, or remove environments from your Explorer configuration.

(3 softData
-0 services # RM - Development
H-[1 Logs # DA - Quality Assurance
03 Security % Prod - Production

Figure 24 Obtaining Environment Information
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1. Select the Environments link under the Configuration header on the left hand side to enter the
configuration information for the newly created logical environment. You will be placed on the
Environments screen. The environments you previously setup will be listed. If an environment is
missing, you must return to the Configuration subtab and add it.

B N

elf‘ Z.\,‘I‘ @ http://localhost/IBFA/

S

o-2¢|

[x]

=3 Insbridge

-3 SofRater

: 3 Engine

A Explorer

L[ SoftData

{3 Services

{3 Logs

{3 Security

?.', SoftLibraries

: @) Help

ORACLE.Insurance Insbridge Framework Administrator

Version 04.09.00 (x64)

Settings

Configuration

Environments

DEVELOPMENT

Environment(s) you may use for development purpases. Selecting an environment below will denote it as the default.

Environment:

Package Location:

DB Server:

DB ServerType:
DB Catalog:

DB CatalogType:
DB Query Buffer:
DB Tablespace:
DB Schema:

DB User:

DE Password:
Engine Type:

Engine Location:

Engine EnvDef:

Enviranment{s) you may use for quality assurance purposes, Selecting an environment below will denote it as the default,

RM
Test Environment...
sQLServer -
Other -
Windows -
LOCALHOST [7] Location is a Cluster

Discover

Enviranment:

Package Location:

DB Server:

DB ServerType:
DB Catalog:

DB CatalogType:
DB Query Buffer:
DB Tablespace:
DE Schema:

QA

TestEnvironment...
SQLServer -
Other -

Copyright © 2000, 2009, Oracle and/or its affiliates. All rights reserved.

Figure 25 Editing Environment

2. The Environment Name will be complete. No changes are needed.

3. RateManager environments will not have a Package Location. No entry will be allowed.

4. Enter in the DBServer name or IP address. This is the database server where the RateManager
database was restored.

5. The DB Server Type will be SQL Server.

6. The DB Catalog is the name of the RateManager database restored in SQL Server.

7. The DB Catalog Type is RateManager.
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10.

11.

12.

13.

DB Query Buffer, DB Tablespace and DB Schema are not required for a RateManager
environment.

Enter the DB User name and Password.
The Engine Type is Windows.

The Engine Location default is LOCALHOST. Most RateManager installations have a local
engine location. If the IBFA engine location is not on the local machine, enter the server name or
IP address where the IBFA engine is located. Do not change LOCALHOST to the name or IP
address of the local machine.

The Engine EnvDef default is a blank field. Most RateManager installations do not require an
entry in this field. If the IBFA engine location is not on the local machine, enter the server name or
IP address where the IBFA engine is located.

Click Save to save your entries. After you have saved your settings, a new tab will be displayed,
Content. This tab will not be needed for a new installation.

No further entries are required at this time. If you want to make additional entries you can.
Additional environments can be added at any time.

If you are running a Windows only environment you can set up your SoftRater databases at this
time. Follow the same procedure of restoring the database, then entering in IBFA.

Optional Setting: Threads

If you know the number of Web Rate Threads you need, you can enter this information now. If you do not
know, you can enter this information later. For more information on threads, please see the IBFA User

Guide.

WARNING: Before changing the number of threads, you should consult with your system

administrator. Setting the number too high can result in poor performance or even a
system crash. If you are unsure of how many threads to use, set the number to 1. For
single processor systems, Insbridge recommends a maximum of 2 threads.

There are three thread settings in the Insbridge system:

Batch Packing Thread: Found on the Preferences screen of RateManager. This setting is the
maximum number of threads to be used for RateManager Batch Packaging. Batch packaging is
building of packages inside RateManager. This thread setting will not affect rating or any other
process in IBFA.

IBFA Web Threads: Found on the SoftRater Engine page in IBFA. This setting is the maximum
number of threads to be used for rating that is sent through the SoftRater web services. If you
want responses to be returned in the order submitted, this thread setting must be higher than the
maximum number of rate requests contained within a single XML request.

IBFA Message Services Threads: Found on the Message Services page in IBFA. Individual
thread usage can be set for Batch Rating, Batch Scenario and SoftRater-Package.

48



Chapter 2 — Updating an Insbridge Application

STEP 6 — INSTALLING THE OBI PUBLISHER

OBI Publisher is necessary for reports. If you do not plan on using reports in RateManager or IBFA, you
do not need to install this program.

STOP: For release 4.9, OBI Publisher must be re-installed. Previous instances of OBI will not work with
release 4.9.

1. Unzip the OBI_PUBLISHER

# OBl Publisher Setup [[=1.3

0Bl Publizsher -
Release Motes, (JJ

Install l [ Zancel

Figure 26 Installing OBI Publisher

2. Click Install. A progress screen will be displayed.

3. When complete, click Close.

4. In order for OBI Publisher to be available to users, you must start the Insbridge Message
Service. The Insbridge Message Service can be started from IBFA or from Server Manager in
Windows 2008.

NOTE: The location and port for OBI Publisher is http://localhost:9704/xmlpserver/. This information may
be needed if you have to make a request to your company’s infrastructure and request the
security team to open the ports used by Publisher.
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OBI Security

The OBI Publisher requires a default User ID and password to be entered in IBFA. OBl is required to

create certain reports in RateManager. Users will receive error messages if the OBI Publisher Credentials

are not completed.

%
E-E3 Insbridge Configuration File [C:\PROGRAM
L—_l SoftRate FILES\ORACLE\IGBU\INSBRIDGE \Webs\IBFA\Systems\SoftRater\Xml\ rnxooml
"" ortRater Please enter the SoftRater Explorer configuration information below.
4 Engine
|
[ SoftData Admin Email Address:
- Services
-4 Logs
B Security
-8 Softlibraries Internet Proxy:
&) Help UserlD Password
Intranet Credentials: (®) Use Anonymous
() Domain UserID Password
OBI Publisher Credentials: UserID Password
Save

Figure 27 OBI Publisher Credentials

1. On the left side menu, select SoftRater-> Explorer.
2. Locate the OBI Publisher Credentials.
3. Enter the default user name and password.

User ID: Administrator
Password: Administrator

4. Click Save to save your entry. You must click Save prior to exiting the page.
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Updating OBI Publisher Password

You can immediately update the OBI Publisher password if you want. The password must be updated in
OBI Publisher and then in IBFA.

1. Enter the OBI Publisher console. http://localhost:9704/xmlpserver where localhost is the machine
where IBFA/RM is installed.

2. Select the Admin tab.
3. Under Security Center, select Users.

4. Select the administrator Username.

TORACLE' Bl Publisher Enterprise

Welcome, administrator Preferences Sign Out Help

Reports | Schedules | Admin
| Admin = Users > Update User: administrator]

q

p User: administrator

Cancel I Apply

Username administrator
* Password

Figure 28 Updating the OBI Publisher Password

5. Enterin a new password and click Apply. This updates the Administrators password.
6. Sign out of OBI Publisher.
7. Enter IBFA.

8. Open the SoftRater Explorer Configuration window. Enter the same password in the OBI
Publisher Credentials.

9. Click Save. The password has been updated.
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STEP 7 — STARTING INSBRIDGE SERVICES

The Insbridge Message Service can be started on the server where Insbridge is installed or from the
Services screen in IBFA.

To start on the server go to Services and select to start Insbridge Message Service.

To Start in IBFA:

Insbridge Message Service Stop

The Insbridge Message Service is a Message Queue Listener that will route all batched messages to an assembly {process)

for execution. These processes may take resources and time to execute. Please consult with you system admin before
configuring the number of listeners per process.

| Batch Rating w | View Messages Edit Process Configuration

If vou see this message, you have not requested a listing from the selected spoke client. Clicking
Wiew Messages will provide yvou with a list view of the first in - first out mes=sages that are waiting to

execute.

Insbridge Task Manager Stop
The Insbridge Task Manager gives you the ahility to execute daily, weekly, hourly, ar by the minute,

View Tasks (This process may take a while to execute)

TASK LAST RUN-DATE START-TIME STATUS

Figure 29 Insbridge Services Screen

1. InIBFA, navigate to the Services page.

2. Next to Insbridge Message Service, click Start. After a few seconds, the buttons will refresh to

indicate that the service is started.

3. Next to Insbridge Task Manager, click Start. After a few seconds, the buttons will refresh to
indicate that the service is started.

It is recommended that you also start the Insbridge Task Manager. The Insbridge Task Manager is a task
queue that lists the tasks that are scheduled to be performed as well as the last time the task was run and

the status.

NOTE: A login screen is displayed on IBFA for new installs. An upgrade does not reset the current

security setting. For example, if a login was not required for IBFA, upgrading to release 04.09.00

will not change that.
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STEP 8 — UPDATING DATABASES

Database updates can be performed in RateManager for the IBRM and IB_Client databases. This is the
recommended way to update these databases. If this is not possible, the SoftRater database can be
updated manually on the machine where they are located.

The SoftRater database needs to be updated manually on the machine where it is located.

To update the RM and IB_Client databases, log into RateManager.

NOTE: You must be a DB Owner to run the update scripts in RateManager.

NOTE: SoftRater update scripts must be run manually. See Manual Updates to the Insbridge Databases
for more information.

Updating Databases in RateManager

The URL for RateManager will be http://INSTALLATIONSERVERNAME/RM. Where Installation server is
the server where RateManager was installed. This places you on the RateManager login screen.

If you log into RateManager and Tools is the only option, you must perform a database update.

r
2 Oracle Insurance Insbridge RateManager 04.09 (10.100.10.10}- .

ORACLE' Insurance Insbridge RateManager
File  Tools Help

Home = @

/| DB Update =]

a Please run the update scripts on the database.

Figure 30 Tool Mandatory Update

1. Enter your username and password.

2. Navigate to the Tools>Database>Updates.

On the DB Updates screen, the current version is highlighted and the status is Current. The
updates below the current version are grayed out. These updates cannot be run again. You will
receive an error message if you attempt to run a lower version update. Any version update above
the current version will also be grayed out but will be available for executing.

Updates have to be installed sequentially, meaning if you are on Version 03.13, you must run the
04.00 update, the 04.01 update, the next, and finally the 04.09.00 update. If you attempt to run an
update that is more than one level above the current version, you will receive an error message.
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3. The Updates tab is displayed. Select the database you want to view from the Show updates for

drop down. The database updates for your selection are listed. The last column, the Status
column, shows you which update is the Current one installed.

Home @ DB Updates x
(&} DB Updates
: [L Execute Update Script | [} Open Update Script Save Update Scriptto File | {gf) Refresh ©
Show updates for:i IERM o iI
Sonpt Release Date Database Status
vwO4.09.00.00 11/1/2014 IBR.M
v04.08.00.00 4/1/2014 IBRM
wO4.07.00.00 3/1/2013 IBR.M
vO4.068.01.00 8/1/2012 IBRM
wi4.068.00.00 3/1/2012 IBR.M

0<4.05.01.00 11/1/2011 IBF.M

04.01.00.00 1171572010 IBR.

O<4.00 00 3/10/2010 IBR.

03.13.0.00 12/15/2009 IBR.

02.12.0.00 4/20,/2009 IER

03.11.0 11/30/2008 IBF.

03.1 8/31/2008 IBR.

03.9.0.00 5/19/2008 IBF.

03.8.0.00 B/ 72007 IBF.

Figure 31 Available Updates

4. There are two ways to execute an update:

a. Directly in RateManager

b. In SQL Server

Directly in RateManager

This is recommended way to update a database. It is recommended that you start by selecting the update
showing Current. This assures that the database showing as Current has all possible updates.

1.

2.

Highlight the update you want to run.
Click EXECUTE UPDATE SCRIPT. A warning message is displayed.
Click OK to run the update or Cancel to return to the previous screen.

Run all script in consecutive order until the 04.09.00 script is showing as current.
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5. Do this for both the IBRM database and the IB_CLIENT database.

& | Confirm Update -- Webpage Dialog Iﬁ

™ Are you sure you want to replace the
current database's contents with the
_-/I selected release script on disk?

2 Ok | & cancel |

e

Figure 32 Updating Scripts in RateManager

6. Click File>Reload to refresh the system

In SQL Server

This method should be performed by a database administrator. No warning messages are displayed if
you execute scripts in the wrong order. You must know the name of the databases you are updating.
Please see Manual Updates to the Insbridge Database.

After you perform the database updates, to view all menu options, click File>Reload.

Updating a SoftRater for Windows Database

For release 04.09.00 SoftRater for Windows requires an update. The SQL database update file is located
in the Insbridge download->Database—>SQL Server-> SoftRater — IBSR->Update folder. There are three
updates scripts.

e Upgrading from release 04.07.00 requires one update script be run, usp_IBSR_v04.08.00.00.sql.

e Upgrading from release 04.05.01 or later, requires two update scripts;
usp_IBSR_v04.06.00.01.sgl, and usp_IBSR_v04.08.00.00.sq|.

e Upgrading from release 04.05 or previous, requires three update scripts;
usp_IBSR_v04.05.01.sql, usp_IBSR_v04.06.00.01.sql, and usp_IBSR_v04.08.00.00.sq|.

Update scripts need to be run manually by the DBA against the SoftRater database. No other steps are
needed.
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STEP 9 — UPDATING PREFERENCES

Administrators can edit web settings at any time from the Preferences option in RateManager. Changes
will take place after the user sessions have been ended. If web settings are changed while the users are
inside the module, the change will not be visible to them. Prior to users accessing RateManager for the

first time, it is recommended that Preferences be set.

To Change Settings

1. Select Tools—>Preferences.

2. This opens the Preferences window. Select Web Settings.

-
Preferences
=-Settings

- User . ~

| e System Settings

= Administrator

system Insbridge Configuration File Path: |C:\PRDGRP-I‘-1 FILES"\DRACLE"\]NSBRJDGE"\FRAME‘.\’DRK‘H.S.O"\]rI
- Migrate Workfiles| Messaging Server: [lecalhost | (Secure channel) []
SoftRater Server : | .NET[v] [locahost | (secure channel) []
Work Files Share Folder Location: | |
DB Backup Share Folder Location: | |
Use Inshridge Com+ Admin: m
Enforce Release Packaging: I@
Batch Package Threads:
Minimum Login User 1D Length: El
User must change password: (Days)
Show Orverride Date Mask: m
Allow Data Type Change: m
Inactive Sessicn Time Cuts El (hrs)
Batch Results with Newiline: I@
Cmnline Help Server: ||D:a|host |
5 . My Recent List: v
Default Proscy Script Location: |hﬂp:,-',-"u’.'pad,-'u.‘pad.da‘t |
e  Save | @ Close |

h

Figure 33 Preferences Settings

3. Make any necessary changes. If you do not know all the settings, you can come back and edit at
a later time. It is recommended that you update the ONLINE HELP Server immediately.

4. When you are finished, click SAVE to update your settings.
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System Setting Options

Insbridge Configuration File Path

The path of the configuration file found in IBFA. This pathway must match the IBFA path. You may need
to change this path if you have changed the path in IBFA. Please contact Insbridge support for further
information.

It is strongly recommended that you leave the default.

Messaging Server

RateManager is set up to run batches on the same server that RateManager is located on. If you have an
especially large batch to run and you want to batch to a different server, you will have to change server
locations here. Unless necessary, it is strongly recommended that you leave the default.

SoftRater Server

If you need to rate on another server, you will have to change server locations here. It is strongly
recommended that you leave the default.

Work Files Share Folder Location

A shared Workfiles location allows for multiple instances of RateManager to share the same Workfiles.
The Insbridge server and the shared location must be on the same domain. The Insbridge user must be
on the domain also.

For instructions on setting up a WorkFiles Share Location, please see the Insbridge WorkFiles Installation
Guide on the http://www.oracle.com/technetwork/documentation/insurance-097481.html

DB Backup Share Folder Location

When you make backups of the RateManager database, you can specify the location of the backup file. If
the location is local, use a local path. If the location is not local, you must be a disk admin to change.

If the database is on a remote server, a share is needed for the backup location. The Insbridge user must
have write access to this location as well.

Use Insbridge Com + Admin

This setting must always be true. If there is a conflict, please contact Oracle Insurance support.

Enforce Release Packaging

When set to False, a release is not required in order for users to create a SoftRater (full) package. False
is the default setting.
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If set to True, a release is required in order for a SoftRater (full) package to be created. If a user wants to
create a SoftRater (full) package in the Program Explorer module, a release must be created in the
Releases area first. This release must have the program added to it and be unlocked. When the user
creates the SoftRater package in Program Explorer, they will have the option to select the Release they
want this package to be placed into. If there is no release, or no release that contains that program and is
unlocked, then the user will be able to do RateManager (local) packages only.

Batch Package Threads

RateManager allows you to change how many threads are used. Threading enables a process to finish
faster by splitting the process into smaller processes that run quasi-simultaneously. On multiprocessor
systems, using multiple threads enables the operating system to assign the threads to different
processors.

In addition, the Framework Administrator also enables you to change the administrator email address for
each client. When a process fails, an email will be sent to the person who initiated the process, as well as
to the administrator email addresses listed for the client of that process.

NOTE: Before changing the number of threads, you should consult with your system
administrator. Setting the number too high can result in poor performance or even a
system crash. If you are unsure of how many threads to use, set the number to 1. For
single processor systems, Oracle Insurance recommends a maximum of 2 threads.

Minimum Login User ID Length

This is the minimum number of characters required for a user ID.

User must change password

This where you set the number of days before a user is required to change his/her password. This setting
will only be active when you elect to have users change their password on the user setup screen.

Show Override Date Mask

If enabled, a date mask for ‘Date’ data types will be displayed when importing a table. If not enabled, this
field will not be visible.

Allow Data Type Change

The type of data associated with a parameter. RateManager supports three (decimal, integer and string)
data types for variables and inputs and a fourth (date) for inputs and result variables only.

Setting this option to True allows RateManager users change the data type of a variable or input. Setting
this option to False does not allow users to change data types.
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Inactive Session Time Out

This is the amount of time that a user sits inactive before being automatically logged out of the system.

Batch Results with New Line

Allows batch results to go to a new line instead of forming one continuous string. A True setting places a
carriage return between result files. A False setting results in one continuous string without a break.

Online Help Server

Online help is installed with RateManager. This setting is the default server name where RateManager
currently resides. Either a server name or an IP address can be entered here. If needed, you can change
the name of the server. For example, if the machine name is not the same as the host name, you may
need to change the name in order for online help to function.

My Recent List

My Recent List is a snap setting. Snaps are modules that contain information or links to elements that the
user recently worked on. You can set the maximum number of elements to display in a snap. The default
is for the snap list to be limited to 10.

Default Proxy Script Location

The Default Proxy Script Location setting may be needed if you elect to use the Oracle Insurance Blog
Feed snap. This setting can be used for RSS feeds.

Change Control

If change control is on, it is mandatory for users to enter a change control entry and justification to any
element or program when it is revisioned. If change control is off, the option is not presented.

Maximum Amount of Simultaneously Opened Tabs

Use the maximum amount of simultaneously opened tabs setting to set the maximum number of tabs you
allow users to have opened in RateManager. The default is 15.

Debug Report Format

Select the debug report format to be used in the Test Program section of RateManager. Debug reports
can be a single report format, where the entire report is listed out or in a summary report format where
information is contained in sections that can be expanded and collapsed. Summary report format may be
useful if large programs are to be run. This setting can be updated at a later time.
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Default Naming Standard

Select the Naming Standard to be applied system. If a Naming Standard is not needed system wide, clear
the field. The default is for the system default to be used. Please see Naming Standards for more
information.

Enable Worksheet for Test Case Editor

Select true to have the option to create a rating or calculations worksheets in Test Case Editor. Select
false and the option to create a worksheet in Test Case Editor is not presented. Please see Worksheets
for more information.
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OPTIONAL STEPS

There are optional steps that can be performed for a RateManager/IBFA update.

Migrating Files

o Step 1: Migrate Files

e Step 2: Update Portal URL

These steps may not be required, depending upon the actions you want to take.
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MIGRATE WORK FILES

This option migrates workfiles from previous versions of RateManager. This procedure is for updates from
release 4.8 or previous or if you are updating to a new machine.

STEP 1 — MIGRATE WORK FILES

Migrating workfiles assures that previous workfiles are available to users. Workfiles are rating, pricing,

mapping and template files used in various areas of RateManager such as Impact Analysis, Library, and

Testing. Migrating files allows users to access work files that were available in previous releases of

RateManager. If you do not migrate work files from previous versions, users will not have access to them.

Work files should be migrated after the upgrade has been run.
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Figure 34 Location of WorkFiles

Prior to migrating files, please create backup copies of the files to be migrated. This requires

access to the server were RateManager has been installed.
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Migrating files is a twp step process.
Step 1: Locate the previous workfiles to be migrated.

The location of the files to be migrated and the exact file name will depend upon what version of
RateManager you want to migrate. There are three possible locations.

For Release 3.12 and earlier:

e File Name: WorkFiles
e Location: \Program Files\InsBridge\Webs\RMxxx\WorkFiles

Where xxx is the version number, i.e. 310, 311, 312
For Release 3.13:
o File Name: Workfiles
o Location: \Program Files\Oracle\IGBU\Insbridge\Webs\RM313\Workfiles
For Release 4.0 To 4.8:

e File Name: Workfiles
e Location: \Program Files\Oracle\IGBU\Insbridge\Webs\RM4\Workfiles

Copy all work files for every version to be migrated and store in a safe location. In the unlikely
event that an error with the migration occurs, you will have backup files that you can place directly
in the RateManager (RM4) Workfiles location or restore to the previous version.

Step 2: Place in the new workfiles location.

New File Location:

e File Name: Workfiles
e Location: \Program Files\Oracle\Insbridge\Webs\RM4\Workfiles
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Performing the Migration in RateManager

This migration process moves rating, pricing, mapping, and template files from a previous version of
RateManager to the current RateManager version. You can select one version that you want to migrate. If
you have more than one version to migrate, you must perform the migration manually. Please refer to the

Installation and Upgrading Guide for instructions.

1. Select Tools>Preferences->Administrator>Migrate Workfiles.

g . o)
Preferences
-l-Settings . . . .
b User This option is used to transition test-case work files from the
previous Rate Manager installation to the current
i Home Page
=~ Administrator | Select to start migrabion ... |
g ystem

o Save | ) Cclose |

h

Figure 35 Migrating Work Files

2. Click the Select to start migration button. A separate screen is displayed.

3. RateManager determines the possible version to migrate. Select the version you want to migrate.
Only work files from the selected version will be migrated.

64



[ a -- Webpage Dialeg ﬁ1

. Migrate Work Files
Migrate files from:

This migration process will move Rating, Pricing, Mappings and Templates from a previous version of
RateManager that you selected to current RateManager. This process could take 2 few minutes to
complete, An alert box will zppear when the process has completed.

Miglﬂtel @ Close |

L

Figure 36 Selecting Workfiles to Migrate

4. Click Migrate.
a -- Webpage Dialog Iﬁ

- Migrate Work Files

. Al current Rating, Pricing, Mapping and Template files wil be deleted in order
!_-/l to migrate the files from the previous RateManager. Do you want to
. continue?

L

Figure 37 Confirming a Migration

5. Click Yes to migrate. If you are unsure about the action you want to take, click No to stop the
migration process.

6. The migration will begin. This process could take a few minutes to complete. When all files have

been migrated, an information notice will be displayed.
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The process has campleted,

L ]
Ry
[ o]
Figure 38 Successful Migration

7. Click OK to close the screen.

Verifying Migrated Files in RateManager

Migrated files are available in the same areas.

@ Oracle Insurance Insbridge RateManager 04.08 (10.100.10.10) -

ORACLE Insurance Insbridge RateManager

File  Modules Tools  Help

| Home | gl Library x
‘ ol Library
 view: Wy Templates = New | #2) Upload from File | &5 Edit Details | [l save toFie | 3§ pelete | &) Refresh ;
Drag a column to this area to group by it. Search:
Name LoB Source Version | Version Name Effective Date Date Created
RC-BP-GA-09012012-V01 BOP ISO-ERC Vo1 BP-GA-09012012-V01 Jun 04 2013 10:03 PM e
RC-BP-AK-08012011-V03 BOP ISO-ERC Vo3 BP-AK-08012011-V03 Jun 04 2013 10:02 PM
RC-BP-AK-09012012-V02 BOP ISO-ERC Vo2 BP-AK-09012012-V02 Jun 04 2013 10:00 PM E
RC-BP-AK-09012012-V01 BOP ISO-ERC Vo1 BP-AK-09012012-V01 Jun 04 2013 09:46 PM
Auto Lab Auto Alamere z BI and PD Premium Nov 28 2012 03:45 AM
Insurance
050-448751-01 Auto Alamerelnsuran 1 Initial Nov 28 2012 12:04 AM
RC-BP-NY-05012012-V02 BOP ISO-ERC Vo2 BP-NY-05012012-V02 May 29 2012 08:58 PM
EQZ ErrorsOmissions LTS 1 Copy of EO1L May 10 2012 06:16 PM
Company
EQZ ErrorsOmissions Insurance 1 Copy of EO1 May 10 2012 04:50 PM
Company
BI_Prem Auto Alamere 1 May 03 2012 07:42 PM
Insurance
EQZ ErrorsOmissions Insurance 1 Copy of EOL May 03 2012 07:38 PM
Company
FLA_Auto Auto Alamere 1 Initial Apr 25 2012 11:03 PM
GLLab General Liability Alamere 3 Total GL Premium Apr 25 2012 11:01 PM
MultiLineTotals Multi-Line Alamere 1 Apr 19 2012 10:44 PM
Insurance
X99-360025-XX Auto Alamerelnsuran 1 XF_NODE Sep 12 2011 01:44 PM
X99-360025-XX Auto Alamerelnsuran 3 February Sep 12 2011 01:44 PM
X99-360025-XX Auto Alamerelnsuran 2 January Sep 12 2011 01:44 PM
050-448751-01 Auto Alamerelnsuran 3 February Sep 12 2011 01:44 PM
050-448751-01 Auto Alamerelnsuran 2 January Sep 12 2011 01:44 PM
050-448751-01 Auto Alamerelnsuran 1 Initial Sep 12 2011 01:43 PM
CONTROLLER General Liability Atlants Cantent Oct 28 2010 11:48 AM
Services -

Total Records: 134

Figure 39 Verifying File Migration in RateManager

To verify that work files from a previous version have been migrated, enter an area where these files
would be used, such as the Library tab.
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The tab refreshes with all available files. Your files from previous versions will be listed.

NOTE: Previous export files will not be migrated. Previous export files are not recognized in current
releases of RateManager.

Manual Migration

A manual migration must be performed under select circumstances. All versions must be on the same
server. If you are working with two separate machines, you must perform the migration manually. A
RateManager migration will perform a copy and paste of the WorkFiles on the server then the previous
versions WorkFiles will be deleted. This means that the version you select to be migrated will have the
WorkFiles deleted from the server. This cannot be reversed. Make sure this is the action you want to take.

If you have more than one version where you want to migrate files, you will have to perform the migration
on the server. DO NOT USE RATEMANAGER TO MIGRATE MULTIPLE VERSIONS. Only one version
can be migrated. If you attempt to migrate more than one version, you will write over any data with the
version that you are migrating. For example, if you migrate version 3.12 and then migrate 3.13, any
information from 3.12 will be written over with the information from 3.13. If you have more than one
version to migrate, you must perform the migration directly on the server.

Verifying the File Migration in the Server

Migrated files will be moved from previous releases into the updated location - \Program
Files\Oracle\Insbridge\Webs\RM4\Workfiles.

. Custom JH[=] B3

G( )v| ~ 10101010100 ~ Program Files - Oracle ~ Inshridge - Webs -~ RM4 ~ Workfiles ~ Mappings - Input ~ Custom - lm.ll Search Custom @
Organize *  Includeinfbrary »  Sharewith *  New Folder == ox O @

Controls ;I Mame ~ Date maodified Type | Size | |
Css

Images || Auta Training Manual Tables, sl 1/3/2011 10:13 PM #5LT File 1 kB
Includes
Licenses

Logindpps

MMain

Modules

Scripk

Ltils
videos

S New Workfile Location

Exports

al

= Mappings
= Input

. Custom

Library
Output
Pricing
Rating
Reports

Templates

hd|
= el

1itemn

Figure 40 Verifying File Migration at Server Level
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You can verify that files have been moved by looking in the
\Program Files\Oracle\insbridge\Webs\RM4\Workfiles folder.

You also can verify that previous WorkFiles have been removed by looking in the prior WorkFiles location
on the server.

Workfiles only need to migrated one time.
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UPDATE PORTAL URL

The Oracle Insurance Insbridge Enterprise Rating Portal (Portal) is a single point of access to the Oracle
Insurance Insbridge Enterprise Rating (Insbridge) system. If you are using a portal, the URL must be
updated to reflect to new application pool settings. The previous extension of IBRU will not work in
release 4.9.

The portal can now be accessed from http://LOCALHOST/insbridge

Where: LOCALHOST is the server where the Insbridge system is installed.

To Update:

Step 1: Locate previous portal settings.
Step 2: Copy from previous portal to new portal.

Step 3: Update URL to insbridge

. Xml =] B

®

9( )v| = 10101010100 ~ Local Disk {C:) = Program Files = Oracle ~ Insbridge = Webs - insbridge = Xml - lmll Search Xml

Crganize *  Includein library ~  Share with +  New Folder = - E:l '@'

=] Cracle :I Mame ~ Date madified Type | Size | |
bin
= IEBU
=] Insbridge
COME =] RMa0. Kl 2/19/2014 1:11 PM *ML Docurnent 1KB
Framewark 2] Snap.xml 1/7/2015 10:53 AM #ML Docurnent 1KB
SOK
SoftR.ater
Webs
IBFA
=] IBRU
App_Data
bin

Images

= IBFAEml 2/19/2014 12:54 PM =ML Docurnent 1KE
= 1655, #ml 117192014 2:59 FM =ML Document 1KEB

o0& E

onlinehelp
Scripk

Previous Portal files

RM<
SoftLibrary
= Insbridge
COM+
Framewark
SOk,
SoftRater
Webs
IEFA
= insbridge
bir

Images

OHMHBH

onlinehelp
Scripk

New Portal location
=

4 itermns

Figure 41 Portal Locations
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Step 1: Locate previous portal settings.

The location of the files to be copied and the exact file name will depend upon what version of
RateManager you want to copy. There are two possible locations.

For Release 3.12 and earlier:

e File Name: Xml
e Location: \Program Files\InsBridge\Webs\IBRU\XmI

For Release 3.13 and later:

e File Name: Xml
e Location: \Program Files\Oracle\IGBU\Insbridge\Webs\IBRU\Xml|

Copy all four XML files and store in a safe location. In the unlikely event that an error occurs, you
will have backup files that you can work with.
Step 2: Copy from previous portal to new portal.
New File Location:
o File Name: Xml
e Location: \Program Files\Oracle\Insbridge\Webs\insbridge\Xml
Step 3: Update URL to insbridge to reflect the application name of insbridge.

The portal can be accessed from http://LOCALHOST/insbridge

If you wish to re-create the portal or want more information, please the Insbridge Enterprise Rating Portal
Configuration Guide.
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Chapter 4

UPGRADING TO A NEW MACHINE

If you are upgrading RateManager/IBFA from any previous release AND moving to a different machine
you will need to perform these steps. These steps will allow any packages loaded to the old machine to
be loaded and used by the new machine. If you do not perform these steps, old packages may not rate
properly or even be available to users.

NOTE: These steps need to be done only when you are migrating your RateManager/IBFA instance
from an old machine to a new machine.

e Step 1: Install RateManager/IBFA

o Step 2: Export the Insbridge Registry Key from the old Machine

e Step 3: Import the registry key from the old machine to the new machine
e Step 4: Copy the Insbridge XML file from the old machine.

e Step 5: Paste the Insbridge XML file in the new machine.

e Step 6: Finish the Installation

e Step 7: Run any needed Database Client — Optional

e Step 8: Manually Migrate Workfiles

After these steps, your RateManager/IBFA should be ready for use.

Step 1: Install RateManager/IBFA

A RateManager/IBFA upgrade that involves moving to a new machine is considered a new install. Please
follow the instructions for installing RateManager/IBFA in the RateManager Installation Guide.

STOP At Step 7 — Configuring Insbridge Framework Administrator.

Do not create a subscriber or environments.

Step 2: Export the Insbridge Registry Key

The Insbridge registry key located in HKEY _LOCAL_MACHINE->SOFTWARE->Insbridge is used to
store all information for proper encryption of the SoftRater Packages (SRPs).

When RateManager/IBFA is re-installed on a new server, a new registry key will be created. The new
registry key will not match the registry key associated with any packages that have been created on the
old machine. In order to load packages to the new machine, you will need to restore the previous registry
key.
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1. On the old machine, enter Registry Editor. Run->regedt32.

2. Select the Insbridge key: HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge.
3. Right click and select Export.

4. Select a storage location for the file and Save.

5. Close out of Registry Editor.

Step 3: Importing the Registry Key

The old registry key needs to be imported in to the new machine.
1. Save the Exported Registry Key to a location you can easily access.
2. Double click the Exported Registry Key. The key will be loaded.

3. Store the Exported Registry Key in a safe location.

Step 4: Copy the Previous Insbridge. XML File

You can copy and paste the Insbridge XML file from the old machine to the new machine. This will allow
the environments and subscriber created in the old machine to be populated in the new machine.

NOTE: If you want to re-enter or re-create your environments, you can skip Step 4 and Step 5. After you
import the registry key, you will need to continue the RateManager/IBFA installation at Step 7 —
Configuring Insbridge Framework Administrator.

File Location:

The location of the Insbridge. XML file to be copied will depend upon what version of RateManager the old
machine is running. There are two possible locations.

For Release 3.12 and earlier:
e File Name: InsBridge.XML
e Location: D:\ProgramFiles\InsBridge\Framework\2.0.2\InsBridge.Xml.
OR C:\Program Files\Oracle\Insbridge\Framework\2.0.0\Insbridge.Xml

For Release 3.13 and later:

e File Name: InsBridge.XML
e Location: C:\Program Files\Oracle\IGBU\Insbridge\Framework\3.5.0\insbridge.Xml

Copy the Insbridge. XML file to a location you can easily access.

NOTE: If you are changing databases, you can copy and paste the Insbridge XML file, however you will
need to update your environments with the new database information.
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Step 5: Paste the Insbridge. XML File

Before pasting the Insbridge. XML file into the new location, make a copy of the blank Insbridge. XML file
and store in a safe location. In the unlikely event that an error occurs, you will have a backup file that you

can use.

The Insbridge. XML file in the New Machine is located:

C:\Program Files\Oracle\Insbridge\Framework\4.5.0\insbridge.Xml

1. Make a copy of the blank Insbridge.XML file on the new machine and store in a safe location.

2. Paste the Insbridge.XML file from the old machine in to the new machine in the same location.

3. Open an Internet Explorer web browser either remotely on the local Insbridge web server and

browse to IBFA location on the new machine: http://SERVERNAME/ibfa/

4. Subscribers and Environments should be available in IBFA on the new machine. Verify your

entries.
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Step 6: Complete the RateManager/IBFA Installation

Complete the instructions for installing RateManager/IBFA. Please see the RateManager Installation
Guide for detailed instructions.

Continue at Step 8 — Verifying the Component Services. You will need to complete the rest of the
installation.

Step 7: Run Database Clients — Optional

This step is optional. You will need to run the Oracle Client or the DB2 Client if you are utilizing a Java
SoftRater, i.e. SoftRater for WebLogic, SoftRater for WebSphere or SoftRater for JBoss. The Oracle
Client is located in the Oracle Cloud Delivery package. The DB2 client is not included and must be
downloaded. For instructions on running the Oracle Client or the DB2 Client, please see the
corresponding SoftRater Installation Guide, i.e. SoftRater for WebLogic Installation Guide, SoftRater for
WebSphere Installation Guide or SoftRater for JBoss Installation Guide.

Please make sure you use the 64-bit client.
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Step 8: Manually Migrate Workfiles

After the installation has been completed, you will need to migrate workfiles. Follow the instructions for
Manually Migrating Workfiles, see page 62.

The RateManager system is ready for use.

NOTE: If users experience any difficulties with migrated packages, please verify that the database
usernames and passwords are entered for any SoftRater environment.

IMPORTING REGISTRY KEY AFTER INSTALLATION

The registry key can be imported at any time after the initial RateManager/IBFA install and subscriber
creation. If the registry key needs to be imported after you have completed the installation and set up your
SoftRater environments, you will need to re-enter Database Username and Passwords for the SoftRater
Environments.

This procedure is only required if you have configured your environments. If you have not configured
your environments, you should not have to re-enter usernames and passwords for your environments.

Prior to starting, IBFA should be up and running on the new machine.

Step 1. Export the Insbridge Registry Key

The Insbridge registry key located in HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge is used to
store all information for proper encryption of the SoftRater Packages (SRPs).

When RateManager/IBFA is re-installed on a new server, a new registry key will be created. The new
registry key will not match the registry key associated with any packages that have been created on the
old machine. In order to load packages to the new machine, you will need to restore the previous registry
key.

1. On the old machine, enter Registry Editor. Run->regedt32.

2. Select the Insbridge key: HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge.

3. Right click and select Export.

4. Select a storage location for the file and Save.

5. Close out of Registry Editor.

Step 2: Importing the Registry Key

The old registry key needs to be imported in to the new machine.

1. Save the Exported Registry Key to a location you can easily access.
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2. Double click the Exported Registry Key. The key will be loaded.

3. Store the Exported Registry Key in a safe location.

Step 3: Re-enter Username and Password

1.

2.

3.

Enter the new IBFA instance.
Browse to SoftRater>Explorer=>Subscriber name.
Select the Environments link under the Configuration header on the left hand side.

You will notice that the database username and password entries will be blank. Please re-enter
the username and password. Test connections for any SoftRater environments.

Save your entries and close out of environments.

Upgrading the Database Machine

If you are upgrading your database machine, the new database information will need to be entered in
IBFA->Environments.
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MANUAL UPDATES TO THE INSBRIDGE DATABASES

The preferred method of updating the IBRM and IB_CLIENT databases is to go into RateManager. If the
administrator has DB User privileges and is the DB Owner of the database as well as the disk
administrator, database updates can be done on the Tools>Database>Updates tab. If these privileges
are not in place, an error message will be displayed. See Step 4 — Updating Databases for more
information.

NOTE: If you need to go from an older version, such as 03.13, it is strongly recommended that you enter
RateManager and run the script successively starting with 04.00, 04.01, and so on until you reach
the 04.09 script. Failure to run scripts in order may result in errors.

To manually update a SQL Server database, you will be required to save off each update and run them in
sequential order in SQL Server. A DBA or a person with the proper permissions will need to apply the
database updates in SQL Server using Query Analyzer.

1. First, you will need to get the scripts you need from RateManager.

2. In RateManager, highlight the update you need. Begin with the version that is listed as “current”.
If you are going from a much lower version of RateManager, you will have to save multiple files.

3. Click Save Update Script to File. Your computers dialog box is displayed. Save the file to a
location of your choice. For IBRM scripts, it is recommended that you rename the file to
usp_IBRM_R(version number).sql. For example the Release 04.09.00 update would be:
usp_IBRM_R04.09.00.sql. For IB_CLIENT scripts, it is recommended that you rename the file to
usp_IB_CLIENT_RO(version number).sql. For example the Release 04.09.00 update would be:
usp_IB_CLIENT_R04.09.00.sq].

4. Verify that you have saved all the necessary scripts from “current” to release 04.09.00. You must
save off update scripts for both the IBRM and the IB_CLIENT databases.

5. Next, enter SQL Server.

NOTE: If you do not have database permissions, you will not be able to perform the following database
gueries.

NOTE: When using Database Engine Query, the SQL scripts must run on each individual database.

6. Begin with the current version of either the IBRM database or the IB_CLIENT database. Open
Query Analyzer.

7. Open up the DB script updates from the download file. You can open in any program you want,
such as Notepad. Begin with the “current” script. For example, if you are going from release 03.13
to 04.09.00, 3.13 should be “current”. Open 3.13 first.
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Figure 44 Updating Database

8. Select the database you want to update. In SQL Server Management Studio, create a new
Database Engine Query, File>New—>Database Engine Query.

9. Copy the first update from Notepad and paste onto the query screen.

10. Click Execute. The script will execute. Any messages will be displayed in the lower portion of the
screen. You must run the updates in sequential order. Run each update until you run the
04.09.00 update.

11. When you have finished updating one database, update the remaining database. Make sure you
do both the IBRM and IB_CLIENT databases.

12. After the scripts have been run, return to RateManager. Click Refresh Listing. The status should
show current and the full RateManager menu should be displayed. The updates are now properly
applied and users can log back in to the system.

NOTE: You can view the update script in RateManager. Select the update you want to view. Click Open

Update Script. The update script will be displayed in a separate screen.

F . |
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Figure 45 Script Viewer
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Updating a SoftRater for Windows Database

Release 04.09.00 SoftRater for Windows does not require an update if you are updating from release
04.08. If you are updating from a previous release, there are update scripts to be run. The SQL database
update file is located in the Insbridge download-> Database—>SQL Server-> SoftRater — IBSR->Update

folder. There are three updates scripts.

e Upgrading from release 04.07.00 requires one update script be run, usp_IBSR_v04.08.00.00.sql.

e Upgrading from release 04.05.01 or later, requires two update scripts;
usp_IBSR_v04.06.00.01.sql, and usp_IBSR_v04.08.00.00.sq|l.

e Upgrading from release 04.05 or previous, requires three update scripts;
usp_IBSR_v04.05.01.sql, usp_IBSR_v04.06.00.01.sql, and usp_IBSR_v04.08.00.00.sq|.

Update scripts need to be run manually by the DBA against the SoftRater database. No other steps are
needed.
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UPGRADING SOFTRATER FOR JAVA

How you upgrade SoftRater for Java depends upon what Insbridge release you are starting from:

Upgrading from Oracle Insurance Insbridge Enterprise Rating Release 3.13.4 or previous to
release 04.09.00 requires that the previous .EAR and config files be removed. The new .EAR file
then can be deployed. The application starting file must be updated as well.

If you are upgrading from release 3.13.5 or later, you need to redeploy the .EAR file and update
the application starting file. You do not need to redeploy the config file.

An update script must be run against the database being utilizing.

If you are upgrading from release 3.12 or previous you should check for SOAP changes. Updated
WSDL documents will need to be incorporated into any client calling application that
communicates with SoftRater. If upgrades are done to the SoftRater for Java engines without
updating the calling applications, the calling application will fail.

NOTE:

UPGRADE YOUR TEST ENVIRONMENT PRIOR TO PRODUCTION. Validate in test prior to
implementing in production.

Steps to Upgrade SoftRater for Java:

Every upgrade requires:

1. Update the application server. Please follow the instruction for the release your application
server is currently running.
e For Release 3.13.4 and Prior, delete the .EAR file and config file.
e For Release 3.13.5 and Later, delete the .EAR file only.
2. Deploy the new .EAR file.
3. Update the application starting file. Every SoftRater for Java requires a new property in the
start file of the application server.
4. Update the associated database. All database updates should be performed by your DBA or
gualified system administrator. This takes the SoftRater databases to release 04.09.00.
NOTE: Updates are performed manually on the database server.
5. OPTIONAL: Update the WSDL documents. You need to perform this step if you are currently

running release 3.12 or previous and incorporating a calling application. This allows your calling
application to function in the upgraded SoftRater. If you are not incorporating a calling application,
you will not need to do this step.
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SOFTRATER UPDATES

There are three SoftRater for Java engines:
o SoftRater for WebLogic
o SoftRater for WebSphere
o SoftRater for JBoss

The upgrade procedures to the application are similar and the upgrade procedure for the associated
databases is the same.

SOAP NOTICE

This notice is for customers currently running a SoftRater for Java engine:

o SoftRater for WebLogic

o SoftRater for WebSphere

o SoftRater for JBoss
Necessary updates have been made to the SoftRater for Java engines:

e SoftRater for WebSphere uses SOAP version 1.1.

e SoftRater for WebLogic uses SOAP version 1.1.

o SoftRater for JBoss uses SOAP version 1.1.
These changes mean that the WSDLs for the SoftRater for Java engines may have been modified since
the last installation of SoftRater for Java. Updated WSDL documents may need to be incorporated into
any client calling application that communicates with SoftRater. If upgrades are done to the SoftRater for
Java engines without updating the calling applications, the calling application will fail.
Please update a test environment prior to deploying to production. Install the .EAR file in a test

environment to obtain the WSDL. Update your calling application and then test again. When testing is
complete, you can upgrade your other environments.

NOTE: Customers running a Windows only environment, without a Java component, will not be affected.

These updates are for the SoftRater for Java engines only.
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UPGRADING WEBLOGIC

SoftRater for WebLogic can be upgraded any time after the Insbridge system. Prior to upgrading,
download the SoftRater for WebLogic Engine Setup zip file from the Oracle Software Delivery Cloud
https://edelivery.oracle.com. Unzip the file and place the contents for Release 04.09.00 in a location you
can easily access. File contents include:

e [IBSS.ear

e Insbridge.net.softraterconfig.xml

NOTE: If you are using a DB2 database, a system property must be added to the startWebLogic file.
Please see the SoftRater for WebLogic Installation Guide for complete instructions when utilizing
a DB2 database.

Upgrading from Release 4.7.x or Later

This method removes the previous .EAR but leaves the config files. This upgrade does not require the
creation of an Instance folder. The configuration information will remain and does not need to be re-
entered in IBSS.

1. With WebLogic running, enter the console and delete the old IBSS.EAR file.

2. Stop the WebLogic Service.

3. Onthe server where WebLogic is installed, locate the configuration folder used in the previous
SoftRater for WebLogic installation. For example:

e In a Windows environment, C:\Insbridge\config
e InaLinux environment, home/ Insbridge/config
This same folder should be used for the update.

4. Delete the old .EAR file. Leave the config.xml file in place. You also can leave the log file and the
Jar file, if present.

5. Place the new IBSS.EAR file in the config folder. Once this file is in place, do not move.
6. Start the WebLogic server.

7. Enter WebLogic and deploy the new .EAR file. For help with installing the .EAR file, please see
the SoftRater for WebLogic Installation Guide.

8. Enter IBSS. All config information should be present. You will not need to re-enter the config
information.

9. Verify your entry and connections in IBFA.

10. Test your configuration and updated calling applications before deploying to production.
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Upgrading from Release 3.13.5t0 4.6.x

This method removes the previous .EAR but leaves the config files. This upgrade is for SoftRater for
WebLogic instances that do not have an Instance file. The configuration information will remain and does
not need to be re-entered in IBSS.

1. With WebLogic running, enter the console and delete the old IBSS_WL.EAR file.

2. Stop the WebLogic Service.

3. Onthe server where WebLogic is installed, locate the configuration folder used in the previous
SoftRater for WebLogic installation. For example:

e In a Windows environment, C:\Insbridge\config
e InaLinux environment, home/ Insbridge/config
This same folder should be used for the update.

4. Delete the old .EAR file. Leave the config.xml file in place. You also can leave the log file and the
Jar file, if present.

5. Place the new IBSS.EAR file in the config folder. Once this file is in place, do not move.

6. A new folder needs to be created under the config folder. This new folder is an instance folder.
We suggest creating an Insbridge config instance folder but you may use any folder name you
want and the folder must be under the config folder. Take note of the location and make sure you
have created this folder prior to deploying the .EAR file. This location serves as the instance
application directory.

e For a Windows environment, C:\Insbridge\config\instance
e For a Linux environment, home/ Insbridge/config/instance

7. A new system property must be added to the startWebLogic file. An Instance property is required.

Place this property after the -DINSBRIDGE_APP_DIR= property.
e -DINSBRIDGE_INSTANCE_APP_DIR="C:\Insbridge\Config\Instance". If you

copy, please verify valid characters have been entered.
In this declaration, add a system property for the instance application directory to the
Java Virtual Machine using the “-D” parameter, then specify
“INSBRIDGE_INSTANCE_APP_DIR” as the name of the new variable.
You must also specify the path where the configuration file will be located. i.e.
“C:\Insbridge\Config\Instance”. Where C:\Insbridge\config\Instance is the folder you
created earlier.

For Linux -DINSBRIDGE_ INSTANCE_APP_DIR="“/home/ INSTALLDIR/ Insbridge/Config/

Instance”

NOTE: Please see the SoftRater for WebLogic Installation Guide for assistance with editing the

startWebLogic file.

8. Start the WebLogic server.
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9.

Enter WebLogic and deploy the new .EAR file. For help with installing the .EAR file, please see
the SoftRater for WebLogic Installation Guide.

10. Enter IBSS. All config information should be present. You will not need to re-enter the config

information.

11. Verify your entry and connections in IBFA.

12. Test your configuration and updated calling applications before deploying to production.

Upgrading from Release 3.13.4 or Previous

This method removes the previous .EAR and config files. The configuration information needs to be re-
entered in IBSS and validated in IBFA.

If you are using SQL Server, please see Preserving Environments for a SQL Server Upgrade on page 97.
The Preserving Environments for SQL Server Upgrade information allows you to keep your existing
environments by editing the config file.

1.

2.

3.

With WebLogic running, enter the console and delete the old IBSS_WL.EAR file.
Stop the WebLogic Service.

On the server where WebLogic is installed, locate the configuration folder used in the previous
SoftRater for WebLogic installation. For example:

e In a Windows environment, C:\Insbridge\config
e Ina Linux environment, home/ Insbridge/config
This same folder should be used for the update.

Within the configuration folder, locate the current Insbridge.net.softraterconfig.xml file and
make a back-up copy. The configuration information needs to be re-entered in IBSS. The updated
config file will not contain this information. This information cannot be directly imported but a copy
of the original file may be helpful when re-entering.

Delete the old config file, and the old .EAR file. You can leave the log file and the .jar file, if
present.

Place the new IBSS.EAR file and the new Insbridge.net.softraterconfig.xml in the config folder.
Once these files are in place, do not move.

A new folder needs to be created under the config folder. This new folder is an instance folder.
We suggest creating an Insbridge config instance folder but you may use any folder name you
want and the folder must be under the config folder. Take note of the location and make sure you
have created this folder prior to deploying the .EAR file. This location serves as the instance
application directory.

e For a Windows environment, C:\Insbridge\config\instance

e For a Linux environment, home/Insbridge/config/instance
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8. A new system property must be added to the startWebLogic file. An Instance property is required.
Place this property after the -DINSBRIDGE_APP_DIR= property.

e -DINSBRIDGE_INSTANCE_APP_DIR="C:\Insbridge\Config\Instance". 1T you
copy, please verify valid characters have been entered.

In this declaration, add a system property for the instance application directory to the
Java Virtual Machine using the “-D” parameter, then specify
“INSBRIDGE_INSTANCE_APP_DIR” as the name of the new variable.

You must also specify the path where the configuration file will be located. i.e.
“C:\Insbridge\Config\Instance”. Where C:\Insbridge\config\Instance is the folder you
created earlier.

For Linux -DINSBRIDGE_ INSTANCE_APP_DIR="“/home/ INSTALLDIR/ Insbridge/Config/
Instance”

NOTE: Please see the SoftRater for WebLogic Installation Guide for assistance with editing the
startWebLogic file.

9. Start the WebLogic server.

10. Enter WebLogic and deploy the new .EAR file. For help with installing the .EAR file, please see
the SoftRater for WebLogic Installation Guide.

11. Enter IBSS. The previous entries will not be listed. You will need to re-enter the config
information. To verify the information, open the previous config file. Scroll to find SoftLibrary
information <lib_ref> and Environment information <connection name=>.

<lib n="0IFAStubAdaptor™ cls="oracle.insurance.pad.0IFALifeRdaptor™ 1="" d="2012-07-30 02:23:43 BM" 3="a" t="2">»
<arguments v="arga">
<arg n="strip-crlf"™ w="true" />
<arg n="stub-mode" w="true" />
<arg n="html-reprt” v="true" />
</argumentsr
</lib>

<1lib n="LOVIestScftData™ cls="com.oracle.igbu.activity.list0fValuesIkfaSoftDatalmpl™ 1="" d4="2012-10-05 07:13:45 AM" s="a" t="2">
<BrQUmEnt3 v="args">
<arg n="wadl-uri"™ v="http://10.100.10.100/ibfa/connectors/softdata.asmx?WSDL" />
</arguments>
</lib>

«1lib n="GetUserslctivityRdaptor™ cls="com.cracle.igbu.activity.GetUseraMockImpl™ 1=""

<1lib n="PolicySubmitMockImpl™ cls="com.oracle.igbu.activity.SubmitPolicyMockImpl™ 1="" d:
<arguments w="args" />
</lib>

<1lib n="Credit"™ cla="CREDIT.jar™ l="checked" d="2011-07-18 11:53:08 RM" 3="a" t="2" /><lib n="FProperty"” cls="Property.jar"” 1l="" d=
"2011-07-18 11:53:21 BM" s="d" t="2" /> S ftLIl ra ry I nf r atl n

<connection name="SR_PROD WL_l1" id="-99" provider="1" dbtype="R" uid="XXMX" pwd="mxxxuxxxxxxxx" dataServer="WINAPPOO7" dataSource=
"IBSE_Alamere"” port="1433" DataDir="C:‘Insbridge\S5R_Fackages." default="false" sgl_block_cnt="" dataSchemaz="" xdb_pl="1" />

</lib_ref>

<connection name="5R_PROD WL_2" id="-99" provider="2" dbtype="R" uid="XX¥X" pwd="mmxxuxxxuxxxx" dataServer="linappl0l.example.com"
dataSource="IBSR__ ALAMFERE 2" port="47479" DataDir="/home/Insbridge Fackage\"™ default="false" sgl_block cnt="" dataSchema="Insbridge™
xdb_pl="1" />

<connection name="SR_PROD WL_3" id="-99" provider="0" dbtype="R" uid="XXXX" pwd="mmxxxxxxxxxxx" dataSerwver="10.100.10.100" dataSourcg=

"IBSE_ALRMERE 3" port="50000" DataDir="C:\insbridge\sr_packages_ Alamere‘\™ default="false" s3gl block cnt="5" dataSchema="Insbridge”
xdb_pl="1" /></config>

Environment Information

Figure 46 Locating Information from Insbridge. XML File
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12. Verify your entry and connections in IBFA.
13. If necessary, obtain any WSDL information from IBSS and update any calling application.

14. Test your configuration and updated calling applications before deploying to production.
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UPGRADING WEBSPHERE

SoftRater for WebSphere can be upgraded any time after the Insbridge system. Prior to upgrading,
download the SoftRater for WebSphere Engine Setup zip file for your version of WebSphere from the
Oracle Software Delivery Cloud https://edelivery.oracle.com. Unzip the file and place the contents for
Release 04.09.00 in a location you can easily access. File contents include:

e |IBSS.ear

e Insbridge.net.softraterconfig.xml

NOTE: If you are using a DB2 database, you will need to reconnect the DB2.jar to the ins.ru.ear file and
the Archetype Created Web Application using the Shared Library Reference section in
WebSphere. This connection is broken when the previous .jar file is deleted.

Upgrading from Release 4.7.x or Later

This method removes the previous .EAR but leaves the config files. This upgrade does not require the
creation of an Instance folder. The configuration information will remain and does not need to be re-
entered in IBSS.

1. With WebSphere running, enter the console and delete the old IBSS WS.EAR file.

2. Stop the WebSphere Service.

3. Onthe server where WebSphere is installed, locate the configuration folder used in the previous
SoftRater for WebSphere installation. For example:

¢ In a Windows environment, C:\Insbridge\config
e Ina Linux environment, home/ Insbridge/config
This same folder should be used for the update.

4. Delete the old .EAR file. Leave the config.xml file in place. You also can leave the log file, if
present.

5. Place the new IBSS.EAR file in the config folder. Once this file is in place, do not move.
6. Start the WebSphere server.

7. Enter WebSphere and deploy the new .EAR file. For help with installing the .EAR file, please see
the SoftRater for WebSphere Installation Guide.

8. Enter IBSS. All config information should be present. You will not need to re-enter the config
information.

9. Verify your entry and connections in IBFA.

10. Test your configuration and updated calling applications before deploying to production.
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Upgrading from Release 3.13.5t0 4.6.x

This method removes the previous .EAR but leaves the config files. This upgrade is for SoftRater for
WebSphere instances that do not have an Instance file. The configuration information will remain and
does not need to be re-entered in IBSS.

1.

2.

3.

10.

11.

12.

13.

14.

With WebSphere running, enter the console and delete the old IBSS_WS.EAR file.
Stop the WebSphere Service.

On the server where WebSphere is installed, locate the configuration folder used in the previous
SoftRater for WebSphere installation. For example:

e In a Windows environment, C:\Insbridge\config
e InaLinux environment, home/ Insbridge/config
This same folder should be used for the update.

Delete the old .EAR file. Leave the config.xml file in place. You also can leave the log file, if
present.

Place the new IBSS.EAR file in the config folder. Once this file is in place, do not move.
A new folder needs to be created under the config folder. This new folder is an instance folder.
We suggest creating an Insbridge config instance folder but you may use any folder name you
want and the folder must be under the config folder. Take note of the location and make sure you
have created this folder prior to deploying the .EAR file. This location serves as the instance
application directory.

e For a Windows environment, C:\Insbridge\config\instance

e For a Linux environment, home/ Insbridge/config/instance
Start the WebSphere server.
A new system property must be added to the Name Space Bindings.
INSBRIDGE_INSTANCE_APP_DIR. from the WebSphere Admin console, browse to the
following location:
Environment - Naming - Name Space Bindings
Change the scope to the Server level and click Apply.
Once you have changed to the server level, click New.
Select String and then click Next.
Create a Name Space Binding and Binding Identifier at the server level called
INSBRIDGE_INSTANCE_APP_DIR. The actual string value is the directory path location where
the Instance file was placed for example, C:\Insbridge\config\instance

Then select Next

Click Finish.
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15. After creating both the Name Space Bindings, Save to the master configuration.
NOTE: Please see the SoftRater for WebSphere Installation Guide for assistance with creating Name

Space Bindings.

16. Enter WebSphere and deploy the new .EAR file. For help with installing the .EAR file, please see
the SoftRater for WebSphere Installation Guide.

17. Enter IBSS. All config information should be present. You will not need to re-enter the config
information.

18. Verify your entry and connections in IBFA.

19. Test your configuration and updated calling applications before deploying to production.

Upgrading from Release 3.13.4 or Previous

This method removes the previous .EAR and config files. The configuration information needs to be re-
entered in IBSS and validated in IBFA.

If you are using SQL Server, please see Preserving Environments for a SQL Server Upgrade on page 97.
The Preserving Environments for SQL Server Upgrade information allows you to keep your existing
environments by editing the config file.

1.

2.

3.

With WebSphere running, enter the console and delete the old IBSS_WS.EAR file.
Stop the WebSphere Service.

On the server where WebSphere is installed, locate the configuration folder used in the previous
SoftRater for WebSphere installation. For example:

¢ In a Windows environment, C:\Insbridge\config
e InaLinux environment, home/ Insbridge/config

This same folder should be used for the update.

Within the configuration folder, locate the current Insbridge.net.softraterconfig.xml file and
make a back-up copy. The configuration information needs to be re-entered in IBSS. The updated
config file will not contain this information. This information cannot be directly imported but a copy
of the original file may be helpful when re-entering.

Delete the old config file, and the old .EAR file. You can leave the log file, if present.

Place the new IBSS.EAR file and the new Insbridge.net.softraterconfig.xml in the config folder.
Once these files are in place, do not move.

A new folder needs to be created under the config folder. This new folder is an instance folder.
We suggest creating an Insbridge config instance folder but you may use any folder name you
want and the folder must be under the config folder. Take note of the location and make sure you
have created this folder prior to deploying the .EAR file. This location serves as the instance
application directory.
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e For a Windows environment, C:\Insbridge\config\instance

e For a Linux environment, home/ Insbridge/config/instance

8. Start the WebSphere server.

9. A new system property must be added to the Name Space Bindings.
INSBRIDGE_INSTANCE_APP_DIR. from the WebSphere Admin console, browse to the
following location:

Environment - Naming > Name Space Bindings

10. Change the scope to the Server level and click Apply.

11. Once you have changed to the server level, click New.

12. Select String and then click Next.

13. Create a Name Space Binding and Binding Identifier at the server level called
INSBRIDGE_INSTANCE_APP_DIR. The actual string value is the directory path location where
the Instance file was placed for example, C:\Insbridge\config\instance

14. Then select Next

15. Click Finish.

16. After creating both the Name Space Bindings, Save to the master configuration.

NOTE: Please see the SoftRater for WebSphere Installation Guide for assistance with creating Name
Space Bindings.

17. Enter WebSphere and deploy the new .EAR file. For help with installing the .EAR file, please see
the SoftRater for WebSphere Installation Guide.

18. Enter IBSS. The previous entries will not be listed. You will need to re-enter the config

information. To verify the information, open the previous config file. Scroll to find SoftLibrary
information <lib_ref> and Environment information <connection name=>.
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<lib_ref>

<1lib n="0IFA3tubRdaptor™ cls="oracle.insurance.pad.0IFALifeRdaptor™ 1="" d="2012-07-30 02:23:43 RM" =
<arguments v="args">
<arg strip-crlfi™ v="true" />
<arg n="stub-mode"” w="trus" />
<arg n="html-reprt"™ v="true" />

" op=mary

</argumentax
</lib>
<1ib n="LOVTestScftData™ cls="com.oracle.igbu.activity.Llist0fValuesIkfaSoftDatalmpl™ 1="" d4d="2012-10-05 07:13:45 AM"™ s="a" t="2">
<arguments v="args">
<arg n="wadl-uri"™ w="http://10.100.10.100/ibfa/connectors/scftdata.asmx?WSDL" />
</arguments>
</Llib>
<1lib n="GetUserslctivityldaptor™ cla="com.oracle.igbu.activity.GetUzeraMockImpl™ 1="" d="2012-12-12 09:27:58 AM" 3="a" t="2" />

«1lib n="PolicySubmitMockImpl™ cls="com.cracle.igbu.activity.SubmitPolicyMockImpl™ 1="" d="2012-07-30 02:23:34 AM" a="a" t="2">
<arguments v="args" />
</lib>

<1lib n="Credit"™ cls="CREDIT.jar™ l="checked" d="2011-07-18 11:53:08 BM" s="a" t="2" /><lib n="Property"” cls="Property.jar" 1=
"2011-07-18 11:53:21 EM" 3="d" t="2" />

SoftLibrary Information

<connection name="SR_PROD WL_1" id="-99" provider="1" dbtype uid="MHMN" pwd="HExEuixxxxxxxx" dataServer="WINAPPOO7" dataSource=
"IBSE_Alamere"” port="1433" DataDir="C:‘Insbridge\S5R_Fackages\" default="false" sgl_block_cnt="" dataSchemas="" xdb_pl="1" />

<connection name="5R_FROD WL_2" id="-99" provider="2" dbtype="R" uid="XX¥X" pwd="xixxuixixxxixx" dataServer="linappl0l.example.com"
dataSource="IBSR__ALRMERE 2" port="47479" DataDir="/home/Insbridge_ Package\" default="false" sql_block cnt="" dataSchema="Insbridge"
xdbk pl="1" />

<connection name="SR_PROD WL_3" id="-99" provider="0" dbtype="R" uid="XXXX" pwd="xxxxxxxxxxxxx" dataSerwver="10.100.10.100" dataScurcg=

"IBSE_ALRMERE 3™ port="50000" DataDir="C:‘\insbridge\sr_packages_Rlamere\" default="false" 3ql block cnt="5" dataSchemz="Insbridge”
xdb_pl="1" /></config>

Environment Information

Figure 47 Locating Information from Insbridge. XML File

19. Verify your entry and connections in IBFA.
20. If necessary, obtain any WSDL information from IBSS and update any calling application.

21. Test your configuration and updated calling applications before deploying to production.
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UPGRADING JBOSS

SoftRater for JBoss can be upgraded any time after the Insbridge system. Prior to upgrading, download
the SoftRater for JBoss Engine Setup zip file from the Oracle Software Delivery Cloud
https://edelivery.oracle.com. Unzip the file and place the contents for Release 04.09.00 in a location you
can easily access. File contents include:

e [IBSS.ear

e Insbridge.net.softraterconfig.xml

NOTE: If you are using a DB2 database, a system property must be added to the server classpath.
Please see the SoftRater for JBoss Installation Guide for complete instructions when utilizing a
DB2 database.

Upgrading from Release 4.7.x or Later

This method removes the previous .EAR but leaves the config files. This upgrade does not require the
creation of an Instance folder. The configuration information will remain and does not need to be re-
entered in IBSS.

1. With JBoss running, enter the console and delete the old IBSS_JB.EAR file.

2. Stop the JBoss Service.

3. Onthe server where JBoss is installed, locate the configuration folder used in the previous
SoftRater for JBoss installation. For example:

e In a Windows environment, C:\Insbridge\config
e InaLinux environment, home/ Insbridge/config
This same folder should be used for the update.

4. Delete the old .EAR file. Leave the config.xml file in place. You also can leave the log file, if
present.

5. Delete the old config file, the old .EAR file, and IBSS.EAR.deploy file. You can leave the log file or
README.txt file, if present.

6. Start the JBoss server.

7. Enter JBoss and deploy the new .EAR file. For help with installing the .EAR file, please see the
SoftRater for JBoss Installation Guide.

8. Enter IBSS. All config information should be present. You will not need to re-enter the config
information.

9. Verify your entry and connections in IBFA.
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10. Test your configuration and updated calling applications before deploying to production.

Upgrading from Release 3.13.5t0 4.6.x

This method removes the previous .EAR but leaves the config files. This upgrade is for SoftRater for
JBoss instances that do not have an Instance file. The configuration information will remain and does not
need to be re-entered in IBSS.

1.

2.

3.

With JBoss running, enter the console and delete the old IBSS_JB.EAR file.
Stop the JBoss Service.

On the server where JBoss is installed, locate the configuration folder used in the previous
SoftRater for JBoss installation. For example:

¢ In a Windows environment, C:\Insbridge\config
e Ina Linux environment, home/ Insbridge/config
This same folder should be used for the update.

Delete the old .EAR file. Leave the config.xml file in place. You also can leave the log file, if
present.

Delete the old config file, the old .EAR file, and IBSS.EAR.deploy file. You can leave the log file or
README.txt file, if present.

A new folder needs to be created under the config folder. This new folder is an instance folder.
We suggest creating an Insbridge config instance folder but you may use any folder name you
want and the folder must be under the config folder. Take note of the location and make sure you
have created this folder prior to deploying the .EAR file. This location serves as the instance
application directory.

e For a Windows environment, C:\Insbridge\config\instance
e For a Linux environment, home/Insbridge/config/instance

A new system property must be added to the startJBoss file. An Instance property is required.
Place this property after the -DINSBRIDGE_APP_DIR= property.

o -DINSBRIDGE_INSTANCE_APP_DIR="C:\Insbridge\Config\Instance". IT you
copy, please verify valid characters have been entered.

In this declaration, add a system property for the instance application directory to the
Java Virtual Machine using the “-D” parameter, then specify
“INSBRIDGE_INSTANCE_APP_DIR” as the name of the new variable.

You must also specify the path where the configuration file will be located. i.e.
“C:\Insbridge\Config\Instance”. Where C:\Insbridge\config\Instance is the folder you
created earlier.

For Linux -DINSBRIDGE_ INSTANCE_APP_DIR=*“/home/ INSTALLDIR/ Insbridge/Config/
Instance”
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NOTE:

Please see the SoftRater for JBoss Installation Guide for assistance with editing the startJBoss
file.

10.

11.

12.

Start the JBoss server.

Enter JBoss and deploy the new .EAR file. For help with installing the .EAR file, please see the
SoftRater for JBoss Installation Guide.

Enter IBSS. All config information should be present. You will not need to re-enter the config
information.

Verify your entry and connections in IBFA.

Test your configuration and updated calling applications before deploying to production.

Upgrading from Release 3.13.4 or Previous

This method removes the previous .EAR and config files. The configuration information needs to be re-
entered in IBSS and validated in IBFA.

If you are using SQL Server, please see Preserving Environments for a SQL Server Upgrade on page 97.
The Preserving Environments for SQL Server Upgrade information allows you to keep your existing
environments by editing the config file.

1.

With JBoss running, enter the console and delete the old IBSS_JB.EAR file. If you do not use the
JBoss console, you can delete the old IBSS file after the service has stopped.

Stop the JBoss Service.

On the server where JBoss is installed, locate the configuration folder used in the previous
SoftRater for JBoss installation. For example:

e In a Windows environment, C:\Insbridge\config

¢ InaLinux environment, home/ Insbridge/config
This same folder should be used for the update.
Within the configuration folder, locate the current Insbridge.net.softraterconfig.xml file and
make a back-up copy. The configuration information needs to be re-entered in IBSS. The updated
config file will not contain this information. This information cannot be directly imported but a copy

of the original file may be helpful when re-entering.

Delete the old config file, the old .EAR file, and IBSS.EAR.deploy file. You can leave the log file or
README.txt file, if present.

Place the new IBSS.EAR file and the new Insbridge.net.softraterconfig.xml in the config folder.
Once these files are in place, do not move.

A new folder needs to be created under the config folder. This new folder is an instance folder.
We suggest creating an Insbridge config instance folder but you may use any folder name you
want and the folder must be under the config folder. Take note of the location and make sure you
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have created this folder prior to deploying the .EAR file. This location serves as the instance
application directory.

e For a Windows environment, C:\Insbridge\config\instance

e For a Linux environment, home/ Insbridge/config/instance

8. A new system property must be added to the startJBoss file. An Instance property is required.

Place this property after the -DINSBRIDGE_APP_DIR= property.
e -DINSBRIDGE_ INSTANCE_APP_DIR="C:\Insbridge\Config\Instance". IT you

copy, please verify valid characters have been entered.
In this declaration, add a system property for the instance application directory to the
Java Virtual Machine using the “-D” parameter, then specify
“INSBRIDGE_INSTANCE_APP_DIR” as the name of the new variable.
You must also specify the path where the configuration file will be located. i.e.
“C:\Insbridge\Config\Instance”. Where C:\Insbridge\config\Instance is the folder you
created earlier.

For Linux ~-DINSBRIDGE_ INSTANCE_APP_DIR="“/home/ INSTALLDIR/ Insbridge/Config/

Instance”

NOTE: Please see the SoftRater for JBoss Installation Guide for assistance with editing the startJBoss

file.

9. Start the JBoss server.

10. Enter JBoss and deploy the new .EAR file. For help with installing the .EAR file, please see the
SoftRater for JBoss Installation Guide. If you do not use the JBoss console, the .EAR file should
deploy when starting.

11. Enter IBSS. The previous entries will not be listed. You will need to re-enter the config

information. To verify the information, open the previous config file. Scroll to find SoftLibrary
information <lib_ref> and Environment information <connection name=>.

95



Chapter 6 — SoftRater Updates

R s s .

<1lib ref>

<lib n="0IFA3tubRdaptor™ cls="oracle.insurance.pa3.0IFALifeRdaptor™ 1="" d="2012-07-30 02:23:43 BM" 3="a" t="2">
<arguments v="args">

<arg n="3trip-crli" v="true" />
<arg stub-mode ="true" />
<arg n="html-reprt"™ v="true" />
</argumentax
</lib>

<1lib n="LOVTestScftData™ clas="com.oracle.igbu.activity.list0fValuesIbfaSoftDatalmpl™ 1="" d4="2012-10-05 07:13:45 AM™
<arguments v="args">
<arg n="wadl-uri"™ w="http://10.100.10.100/ibfa/connectors/scftdata.asmx?WSDL" />

</arguments>
</Llib>
<1lib n="GetUserslctivityldaptor™ cla="com.oracle.igbu.activity.GetUzeraMockImpl™ 1="" d="2012-12-12 09:27:58 AM" 3="a" t="2" />
«1lib n="PolicySubmitMockImpl™ cls="com.cracle.igbu.activity.SubmitPolicyMockImpl™ 1="" d="2012-07-30 02:23:34 AM" a="a" t="2">
<arguments v="args" />
</lib>
<1lib n="Credit" cls="CREDIT.jar™ l="checked"” d="2011-07-18 11:53:08 BM" s="a" t="2" /><lib n="Froperty” cls="Froperty.jar" 1="" d=

"2011-07-18 11:53:21 AM" s="d" t="2" />

Softlerary Information

<connection name="SR_PROD WL_1" id="-99" provider="1" dbtype="R" uid="XXX" pwd="xxxxxxxixxxxxx" dataServer="WINAPPOO7" dataSource=
"IB3E_Alamere" port="1433" DataDir="C:‘Insbridge‘\5F_FPackages\" default="false" sgl_bklock_cnt="" dataSchema="" xdb_pl="1" />

</lib_ref>

<connection name="5F_FROD WL 2" i
dataSource="IB5SE__ ALAMERE 2" port="47479" DataDir=
xdb_pl="1" />

Uid="M3" pwd="XEXXixixxxxxx" dataServer="linappl0l.example.com”
/home/Insbridge_Package\™ default="false™ sql block cnt="" dataSchema="Insbridge"”

<connection name="SR_PROD WL_3" id="-99" provider="0" dbtype="R" uid="XXXX" pwd="xxxxxxxxxxxxx" dataSerwver="10.100.10.100" dataScurcg=
"IBSE_ALRMERE 3™ port="50000" DataDir="C:‘\insbridge\sr_packages_Rlamere\" default="false" 3ql block cnt="5" dataSchemz="Insbridge”
xdb_pl="1" /></config>

Environment Information

Figure 48 Locating Information from Insbridge. XML File

12. Verify your entry and connections in IBFA.
13. If necessary, obtain any WSDL information from IBSS and update any calling application.

14. Test your configuration and updated calling applications before deploying to production.

Common Errors

If you experience any deployment issues, look for a deploy fail file in the deployments folder. Delete the
deploy fail file and try again.
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Preserving Environments for a SQL Server Upgrade

NOTE: You do not need to do perform this action if you are running release 3.13.5, or later. These steps
are not necessary if you do not want to keep your existing environments.

If you are utilizing SQL Server and want to keep your current Environment settings, you will need to edit
the insbridge.net.softraterconfig.xml file.

1. Deploy the new .EAR file.

2. Open the insbridge.net.softraterconfig.xml. The insbridge.net.softraterconfig.xml file will be
located in the folder you setup when you initially installed SoftRater for WebLogic. For example,
C:\Insbridge\config.

3. Make a back-up copy of this file.
4. In the insbridge.net.softraterconfig.xml file, find this section:

<jdbcDriver provider="1" name="SQLSERVER">
<jdbcDriverClassName>com.microsoft.jdbc.sqglserver.SQLServerDriver</jdbcDriverClassName>
<jdbcUrlPrefix>jdbc:microsoft:sqlserver://</jdbcUrlPrefix>
<jdbcFetchSize>25</jdbcFetchSize>

</idbcDriver>

And replace it with this:

<jdbcDriver provider="1" name="SQLSERVER">
<jdbcDriverClassName>com.microsoft.sqlserver.jdbc.SQLServerDriver</jdbcDriverClassName>
<jdbcUrlPrefix>jdbc:sqlserver://</jdbcUrlPrefix>
<jdbcFetchSize>25</jdbcFetchSize>

</idbcDriver>

5. Restart the Application Server.
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UPDATING SOFTRATER FOR JAVA DATABASES

After the application servers have been updated, you may need to update the database servers.
All database updates for SoftRater engines must be performed manually. Upgrading from release
04.07.00 does not require an update.

SQL Server Update

SoftRater for Java utilizing a SQL Server database requires an update script be run against the
SQL Server database.

The SQL database update file is located in the Insbridge download->Database—>SQL
Server-> SoftRater — IBSR->Update folder. There are three updates scripts.

e Upgrading from release 04.07.00 requires one update script be run,
usp_IBSR_v04.08.00.00.sql.

e Upgrading from release 04.05.01 or later, requires two update scripts;
usp_IBSR_v04.06.00.01.sql, and usp_IBSR_v04.08.00.00.sq|.

e Upgrading from release 04.05 or previous, requires three update scripts;
usp_IBSR_v04.05.01.sql, usp_IBSR_v04.06.00.01.sgl, and usp_IBSR_v04.08.00.00.sq!.

Update scripts need to be run manually by the DBA against the SoftRater database. No other
steps are needed.

Oracle Database Update

SoftRater for Java utilizing an Oracle database may require an update script be run against the
Oracle database. Upgrading from release 04.07.00 does not require an update.

The Oracle database update file is located in the Database—> Oracle-> SoftRater - IBSR->Update
folder. The file name is usp_IBSR_v04.07.00.oracle. Run the script against the database to
update. No other steps are needed.

DB2 Database Update

SoftRater for Java utilizing a DB2 database may require an update script to be run against the
DB2 database. Upgrading from release 04.07.00 does not require an update.

The DB2 database update file is located in the Insbridge download-> Database->DB2-> SoftRater
— IBSR->Update folder. The file name is usp_IBSR_v04.07.00.db2. Run the script against the
database to update. No other steps are needed.
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CREATING AN APPLICATION POOL

If the Insbridge application pool needs to be created, you can create one. The Insbridge
installation must be complete prior to creating an application pool. Make sure that Static Content
is enabled in the Server Manager Roles.

There are three steps to creating an Insbridge application pool and then assigning the virtual
directories.

e Step 1: Create or Verify an Insbridge Application Pool.
e Step 2: Verify settings.

e Step 3: Associate the Insbridge application pool with virtual directories IBFA, insbridge,
RM

1. Click Start > Administrative Tools - select IIS Manager.

2. Expand the Local Computer and select Application Pools. Right click and select Add
Application Pool.

™E Internet Information Services (T15) Manager [_[O]x]
@ 'S [,;-‘ » SERVER » Application Pools |- @ -

File  Wiew Help

Q- i |2 18 GJ! Application Pools

_; Add Application Poal...

-4 Start Page

Set Application Pool Defaults. ..
563 SERVER This page lets you view and manage the list of application pools on the server. Application pools are associsted with worker em
£ o ntain one o more applications, and provide isolation among different applications. (7] Help
L |-=_, Add Application Poal... ‘ = -
| Sites —_— ) = (G0 - \g5how All | Group by No Grouping - Online Help
W3 Refresh [Status | .NET Frame... | Managed Pipeli... | Identit [ applications |
,;?ASP‘NET w40 Started w40 Integrated ApplicationPoollden... 0
QASP‘NET w40 Classic Started w40 Classic ApplicationPoollden... 0
,g_:?CIass\c \MET AppPool Started w20 lassic ApplicationPoollden... 0
) DefaultAppPal Started 2.0 Integrated applicationPoollden... 2

Ready

&

Figure 49 Navigating to Application Pool
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3. Enter “Insbridge” for the Application pool Name. Select the v4.0 for the .NET Framework
version. Click OK. You will be returned to the IIS screen. Your new application pool is listed.

Add Application Pool E I

Marme:
IInsI:uriu:Ige

[MET Eramework version;

MET Framework, wd.0

Managed pipeline mode:
IIntegrated j

v Start application poal immediakely:

K I Zancel

Figure 50 Creating a New Application Pool
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Step 2: Update Settings

1. Right click the Insbridge Application Pool you created and select Advanced Settings.

Advanced Settings H

Y

il
i MET Framework Version

y4.0
Enable 32-Bit Applications False
Managed Pipeline Mode Inkeqrated
Marme IMNSERIDGE
Queus Length 1000
Skart Automatically True

E CrPu
Lirnit 1]
Limit: Action Modckion
Limit Inkerval (minutes) 5
Processar Affinity Enabled False —
Processar AFFinity Mask:, 4794957295
E Process Model

Identity Insbridge
Idle Time-out {minutes) 1]
Load User Profile False
PMaxirmum YWorker Processes 1
Pirng Enabled True
PFing Maximum Response Time (seconc 90
Ping Period (seconds) 30
Shukdawn Tirme Limik (seconds) a0
Skartun Time Limik fosrnndst an hd

Mame

[mame] The application pool name is the unique identifier For the application poal.

Ik

Cancel |

4

Figure 51 Selecting Application Pool Properties

2. Verify that the .NET Framework Version is v4.0.

3. Verify the identity is Insbridge. If the identity is not Insbridge, you can update it. For the

Identity choose to use custom account and enter the same user that was used to install

Insbridge.

4. Click OK to save your changes.

101



Appendix A — Creating an Application Pool

Step 3: Associate the web applications with the Insbridge Application Pool

Next, you will need verify or associate the Insbridge web applications with the new Insbridge
application pool.

1. Stay in lIS Manager. Under Local Server = Sites = select IBFA, right click and select
Manage Application-> Advanced Settings.

*E Internet Information Services (115) Manager [_]O]
@..4 | @ » server » stes » Defabwebsie » 1BFA | & @ -

Eile Yiew Help

_ &) /IBFA Home T—
@-H & |8 LEf /I 2 Explore
-~ Start Page = Edit Permissions
B ‘*j SERVER Filter: - Bco - Gshow al | Group by frea - & : :
i (2} Application Pools ASP.NET N (5] Basic Settings...
Erial 2.;5 P — @ iew Virtual Dirsctories
E43) Default Weh Site = > - Ea
a = DT = bl
7 aspret_dient % N E [c; =V ab Manage Application -
- .MET .MET Ertor .MET MET Profile JMET Trust Application Connection B applicati
| Explore ampilation Pages Globalization Levels Settings Strings TOwSe e N

Browse *:&0 {http)

Edit Permissions... =

ages and  Session State  SMTP E-mail @' Help

#. Add virtual Directory... Controls :
online Help
‘ Manage Application 3 ‘ Browse
K3 Refresh Advanced Settings... |
XK Remove EE% \ﬁl P i = L ‘C;P 1
(2 Switch to Content Yiew thotization  Compression Defaul: Directory Error Pages Failed Request  Handler
Rules Document Browsing Tracing Rules Mappings
: F 0 = M o o=
= b . i‘bo& =
g 1'9 = j’l 4=} v w2 =
HTTP Redirect HTTP IP Address Lagging MIME Types Modules Qutput Request
Respo,.. and Dom,.. Zaching Filtering
550 Settings -
Management
— P [
E] Features Wiew |, Content View
Ready L=

Figure 52 Associating the Virtual Directories with the Insbridge Application Pool

2. Under the General Settings = Application Pool, click the Application Pool entry field to see
the ellipsis (...) button.
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Advanced Settings E

B {General)
Application Pool DefaultAppPool
Phesical Path C:"PROGRAM FILES, ORACLEYINSEBRID
Phesical Path Credentials
Pheysical Path Credentials Logon Type  ClearText

Wirtual Path ITBF A
E Behavior
Enabled Protocaols http

select Application Pool Ed |

application pool:
IMSERIDGE

Properties:

Met Framework Yersion: 4.0
Pipeline mode: Integrated

(0] 4 I Cancel

Application Pool
[applicationPoal] Configures this application ko run in the specified application poal,

Ik Cancel |

4

Figure 53 Adding Application to Application Pool

3. Click the ellipsis button. A separate window is displayed.

4. Select the Insbridge Application Pool.

5. Click OK. Click OK again to close the Advanced Settings window.

6. Repeat for RM, and Insbridge.

7. Return to the Insbridge application pool. Right click and select to view the applications.
8. Right click to View Applications. The three Insbridge applications should be listed.

9. Select the server level above the application pools and restart IIS. On the IIS screen,
Actions>Restart IIS.
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*E Internet Information Services (115) Manager [_ O] x|

@‘_.‘, [‘!‘3 » SERVER » | |@ ~

e Miew Help

@9 SERVER Home
’ Manage Server
Filter: - Go - %Show Al |Group by Area ~ B
Application Py ASP.NET = B Start
-/ Application Pools . =
Po= B stop
El-[a] Sites & —_— 3
400 Default Web Site = > - q .E ‘
@ % N 405 ¢ =R = ab ? View Application Poals
MET ET ET Error ET METTrust  Application  Cormection  Maching Key Viow o
Authorizati,..  Compilation Pages Globalization Levels Settings Strings Change .HET Framena il
ﬁ _Q\?_ % “!:-I @ e
= e = Orline Help
Pages and Providers  Session State  SMTP E-mail
Controls
s
A 5 9 [ T B @
d B3 d e 1 B &
Authentication Authorization  Compression Default Directory Error Pages Failed Request  Handler
Rules Document Browsing Tracing Rules Mappings
- e R ? = ﬂj =L hn
b e : 4 : = e |
& e o 5 é = IE, +
HTTP Redirect HTTP IP Address  ISAPLand CGL 1SAPI Filters Logging MIME Types Modules
Respo... and Dam. .. Restrickions
s -
e & Ey!
= # «Xy
Qutput Request Server Warker p—
Caching Filtering Certificates Processes
Management
== E 2N T [ ¥ == - |
E] Features Wiew || Content View
Ready

Figure 54 Restarting IS
Application Pool Error

If you choose not to create an Insbridge Application Pool, the Insbridge application will use the

default application pool. If you receive an error when accessing IBFA for the first time after a new
install:

CS0016: Could not write to output file
‘c:\Windows\Microsoft. NET\Framework64\v2.0.50727\Temporary ASP.NET
Files\ibfa\783d6267\bccaOb3e\App_global.asax.zf-kqiii.dIlI': 'Access is denied. "

You may have to create a separate Insbridge Application Pool.
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Support

CONTACTING SUPPORT

If you need assistance with an Oracle Insurance Insbridge Enterprise Rating System product, please log
a Service Request using My Oracle Support at https://support.oracle.com/.

Oracle customers have access to electronic support through My Oracle Support. For information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Address any additional inquiries to:

Oracle Corporation

World Headquarters

500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

Worldwide Inquiries:
Phone: +1.650.506.7000
Fax: +1.650.506.7200

oracle.com
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